F=RTIOET - -

New Features Guide

FortiAnalyzer 8.0.0




FORTINET DOCUMENT LIBRARY
https://docs.fortinet.com

FORTINET VIDEO LIBRARY
https://video.fortinet.com

FORTINET BLOG
https://blog.fortinet.com

CUSTOMER SERVICE & SUPPORT
https://support.fortinet.com

FORTINET TRAINING & CERTIFICATION PROGRAM
https://www.fortinet.com/training-certification

FORTINET TRAINING INSTITUTE
https://training.fortinet.com

FORTIGUARD LABS
https://www.fortiguard.com

END USER LICENSE AGREEMENT
https://www.fortinet.com/doc/legal/EULA.pdf

FEEDBACK
Email: techdoc@fortinet.com

=:RTINET

May 5, 2026
FortiAnalyzer 8.0.0 New Features Guide
05-800-1211640-20260505


https://docs.fortinet.com/
https://video.fortinet.com/
https://blog.fortinet.com/
https://support.fortinet.com/
https://www.fortinet.com/training-certification
https://training.fortinet.com/
https://www.fortiguard.com/
https://www.fortinet.com/doc/legal/EULA.pdf
mailto:techdoc@fortinet.com

TABLE OF CONTENTS

Change Log ... 4
OV IVIBW 5
Security Operations (SOC) ... 6
SOC automation ... 6
Playbook editor improvements ... 6
Incident and Alert Management 9
Alert explorer improvements ... .. 9
Dashboards . ... 10
Al Access Visibility dashboard ... 10
Asset and Iden ity 12
Improvements to the user experience in the Asset and Identity Center ................ 12
OIS 15
FortiMQ connector for automated blocking ... 16
Machine learning for anomaly detection ... 21
Log and Report . . 33
LOOOING 33
FortiData inCident SUPP O ... 33

Log Forwarding ...l 35
FortiAnalyzer Fluentd supports the Azure Monitor Log Ingestion APl ................. . 36
RO S 37
Anomaly l0gin reP Ot 38
FortiDeceptorincident report ... 42
Shadow-Al reP Ot . 48
FortiAl 53
FortiAl alert triage agent ... 53
FortiAl threat posture timeline ... 55
S S M 59
O NS 59
Legal third party disclosure panel ... 59
Custom session labels in FortiAnalyzereventlogs ... 61
SAML SSO supports SHA-256 and SHA-512 for both ldPand SP ........................ 65
FortiAnalyzer supports NTPv4 with SHA-256 encryption ... 66
Time-base retention is configurable for the task monitor and eventlog .............. 68
FortiAnalyzer Fabric .. 68
Assign access to multiple fabric groups for a singleadmin ... 69
FortiAnalyzer Fabric Supervisor HA ... 71
INdeX 76
8.0.0 76

FortiAnalyzer 8.0.0 New Features Guide
Fortinet Inc.



Change Log

Date Change Description

2026-04-21 Initial release.

2026-05-05 Added:
¢ Playbook editor improvements on page 6

« Alert explorer improvements on page 9

¢ Al Access Visibility dashboard on page 10

» Machine learning for anomaly detection on page 21
¢ Shadow-Al report on page 48

» FortiAl alert triage agent on page 53

¢ FortiAl threat posture timeline on page 55

» FortiAnalyzer Fabric Supervisor HA on page 71

2026-05-13 Added:
e SAML SSO supports SHA-256 and SHA-512 for both IdP and SP on page 65
¢ FortiAnalyzer supports NTPv4 with SHA-256 encryption on page 66

2026-05-14 Added:

¢ Time-base retention is configurable for the task monitor and event log on page
68
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Overview

This guide provides details of new features introduced in FortiAnalyzer 8.0. For each feature, the guide provides
detailed information on configuration, requirements, and limitations, as applicable.

The FortiAnalyzer new features are organized into the following categories:

» Security Operations (SOC) on page 6
e Logand Report on page 33

e FortiAl on page 53

e System on page 59

For alist of all features organized by the version number that they were introduced, see Index on page 76.
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Security Operations (SOC)

Security Operations (SOC)

This section lists the new features added to FortiAnalyzer for security operations (SOC):

SOC automation on page 6

Incident and Alert Management on page 9
Dashboards on page 10

Asset and Identity on page 12

Others on page 15

SOC automation

This section lists the new features added to FortiAnalyzer for SOC automation:

Playbook editor improvements on page 6

Playbook editor improvements

[
s,

g This information is also available in the FortiAnalyzer 8.0 Administration Guide:
¢ Playbooks

The playbook editor in FortiAnalyzer 8.0.0 has been improved with a variety of features, including:

Step-by-step debugging mode, including the capability to run, pause, and inspect data at each node (task).
Play and re-play workflows, allowing you to use various input data for testing.

Partial run capabilities, allowing you to restart from a specific node (task) instead of running the whole
playbook.

Extended workflow control support, including Branch(if), Wait Operator, Compare, and Switch.
Jinja template support for control conditions and loops.

Below are some examples of the improvements with images included for reference. For complete instruction to
create a playbook, see the FortiAnalyzer Administration Guide.
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Security Operations (SOC)

When selecting a connector for a playbook task, the unconfigured or inactive connectors are grayed out.
ADOM:roct > @~ O °admln |

Select Connector Type x

FAZ-202-Al

@ Dashboards

22 Device Manager Search connectors by name or type

& Foriv Fortinet Connectors (11)
rtiView

] Log View LocalHost @ FortiClient EMS

Fabric View

Incidents & Alerts

Incidents —~

Al ((=]) FortieDR
- &)

Alert Handlers

Alert Collectors

7N
({B} ) Fortiweb
Indicators \!/

FortiGuard Services

N
Automation /) FortiSandbox

N
) FortiAuthenticator
5
Log Parsers
p . N
@ FortiAl (WA ) FortiMQ
_/
B Reports
Third-Party Connectors (3)
£ System Settings

=N
(S]) VirusTotal
\Zl/

FATINET v8.0.0 Cancel

When configuring a task, the Input pane allows you to run the prior task and get results to use for debugging the
current task. The output from the current task displays in the Output pane at the right.

FAZ-202-Al

¢, Back to Canvas

(©] Get Endpoint Vulnerabilities
INPUT . OUTPUT

Task: get_events (1 item) Parameters + Control Execution Preview (Dry Run) «

LocalHost / LOCALHOST_GET_ENDPOINT_VULNERABILITIES o
>

v{

Name endpoint_vuln w result : [ 10wems

- -

Description Get endpoint vulnerabilties Vulnerability :

b events : [ 10items ]

Connector @ LocalHost ( active )

Endpoint ID @ {fitem.epid}} :v{ulnerahility :

Loop
1(
Type ForEach vulnerability :

Items {{ get_events.events }}

3:{
Break Condition 5 vulnerability :

Each Item Condition {%- set ns = namespace(matched=false) -%}

vulnerability :
vulnerability :
vulnerability :

vulnerability :

Save Cancel
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Security Operations (SOC)

When editing the properties for a connector action (task), you can use Jinja to configure conditions and loops.

Edit Jinja Template of Each ltem Condition

Previous Task Data Entry Template
1. get_events {{get_events.events]}

1 {%- set ns = namespace(matched=false) -%}

2
3 {%- for item in get_events.events | default([]) -%}
{%- if item.epid | int == 41596 -}
{%- set ns.matched = true -%}
{%- endif -%}
{%- endfor -%}
{

{ ns.matched }}

Usage Examples

Execute the whole playbook by clicking Execute Workflow beneath the trigger step.

(™ raz202-A1 = Q-

@ Dashboards Summary | Active Connectors JESEVLGLISN Playbook Monitor

30 Device Manager =i Gk

B Fortiview

Name test_create
[ Log View Description Custom build playbook to get started

Enabled o)
Fabric View

+ -
Incidents & Alerts
Incidents > O @
(]

ON_DEMAND

STARTER q_i ;
v

ey
Get Alerts
-]

Alerts
Alert Handlers
Alert Collectors
et events
Indicators i v Piienyy Get Endpoint Vulnerabilite ® o ttem
& Execute workflow setendeoitiaber ——
FortiGuard Services

Automation

a

Log Parsers

© FortiAl

B Reports

¥ System Settings

FOATINET 00 oK Gancel
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Security Operations (SOC)

Execute step-by-step tasks by clicking the Execute button for the respective task. You can also delete or skip

the current action by clicking the Stop button or Delete button for the respective task.
(™ FAz202-AI = Q- ADOM:rcot >~ @~ © o admin ~

@B Dashboards Pl Summary | Active Connectors JZENVNIE Playbook Monitor O

B Device Manager Ei by el x
FortiView
3 Name get_endpoints_viun
M Log View Description Custom build playbook to get started
Enabled [ o]
Fabric View
+ —|
2 Incidents & Alerts
Incidents
Alerts Iy [
- ON_DEMAND b O [ @
ert Handlers
Alert Collectors - Q— i Get Endpoint Vulnerabilitie
s getevents v endpoint_vuln *
Indicators 5 . _ o

FortiGuard Services
Automation

Log Parsers

© FortiAl

B Reports

£ System Settings

F--ATINET PN OK Cancel

Incident and Alert Management

This section lists the new features added to FortiAnalyzer for incident and alert management:

o Alert explorerimprovements on page 9

Alert explorer improvements

[
s,

g This information is also available in the FortiAnalyzer 8.0 Administration Guide:
e Explorer

FortiAnalyzer 8.0.0 introduces improvements to Incidents & Alerts > Alerts > Explorer:

e The quick filters are sized to fit the width of the screen, so you do not have to scroll to find information.

» The Timeline chart is disabled by default to make more space for the Quick Filters and Related Alerts.

» A new option has been added to the Actions. Click Details to display information about the alert, handler,
logs, and rules.

For more information about using this pane, see the FortiAnalyzer Administration Guide.
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Security Operations (SOC)

(™ FAZVM64-59 = Q- ADOM:root >_ @~ L2 ° admin ~
@ Dashboards [SPTSCH AllAlets | By Endpoint | By Threat | System Events | Custom View | Toggle Views O
B Device Manager AllDevicesv @ Last 12 Hours v 2026-04-23 03:04:00 - 2026-04-2315:0400 & Refresh v @View Options
i Aert 10 © Host 1 @ Source 4 @ Target 1 @ User 55 @
Lo Vi Search Fiter Search Filter Search Fiter Search Filter Search Fiter
Aol Logh Deteciion 127 || noenoughinfo 21361 | /A 5160 || N/A 15943 9| /A 60277 §
B Fere e 1-all-feache 126 14 6636 14 648 | FG3K2C 10864 3435
2 Incidents & Alerts o a— 126 A 4795 || FGL01E4 348 14 1138 1535
Incidents system login new 121 32 3393 215 336 | FGWM 931 1036
e L-ndistinct 118 a3 2934 204 280 109 840 625
Alert Handlers 1-Distinct 13 | : 215 2027 214 252 || null 771 250
ert Collector 1ips 112 || notimplemented dev type 2006 250 52 752 212
Ficron Related Alerts Scarch |
;:;mmd e b O Severitys |LlastOccurreds | Alerts Source = Target = User = Alert Type = | Alert Status ﬂ
O Ex 4 minutes ago astip: 60 60 Traffic
O Ex 19 minutes ago astip: 96 % Traffic
e o a minute ago devid:FGVMI FGUM N/A Event
O Medim afewsecondsago | dstip: 46 46 N/A Traffic
O Medium afewsecondsago | dstip: 46 46 N/A Traffic
O Medim afewsecondsago | dstip: 46 46 N/A Traffic
O Medim afewsecondsago | dstip: 46 46 N/A Traffic
O Medim afewsecondsago | dstip: 46 appDNS srcip:: 14 14 46 N/A Traffic
O Medium afewsecondsago  endpoint: 14 srcip: 14 dstip: 46 14 14 N/A Traffic
O Medim afewsecondsago  dstip 6 : 46 N/A Traffic

F:RATINET 50 - /Page- 3[a]5>»] 1393

Dashboards

This section lists the new features added to FortiAnalyzer for dashboards:

¢ Al Access Visibility dashboard on page 10

Al Access Visibility dashboard

Ly

g This information is also available in the FortiAnalyzer 8.0 Administration Guide:
¢ Al Access Visibility

The Al Access Visibility dashboard has been added in FortiAnalyzer 8.0.0.

This dashboard displays Al access security information collected by authorized FortiGate devices, including:
e DLPlogs
» DNS logs (category = Artificial Intelligence Technology)

Web filter logs (category = Artificial Intelligence Technology)

» Application control logs (category = Generative Al)

You can filter the Al Access Visibility dashboard by timeframe and manually refresh the data or set a refresh
interval.
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Security Operations (SOC)

(™ FazvM_ 025

@ Dashboards v [[iEdit| @ Last1Wesk v 2026-03-23 15:38:18 - 2026-03-30 15:38:18 A [ Refresh [ v |
Status
Email Metrics 44.8K vassi0 Vs 82 ve2 2
SOC Dashboard DLP Violation Threats Detected Sensitive Data Detected
(44.3K Alerted / 500 Blocked) (0 Alerted / 82 Blocked)
Endpoint Vulnerability
XDR Dashboard
@ sanctioned @ Unsanctioned
Al Access Visibility
= Device Manager 1 @& Productivity Assistant 2 m Conversational Assistant
33 Applications ~ CHN— 27 Applications  CHNE—
& Fortiview > . 2 Users — 5 Users —
1 Log View R . Most popular APP @ @B PopAi Most popular APP @) @ OpenAl.ChatGPT
@ Fabric View >
3 @ Image Generator 4 [ Audio Generator
Incidents & Alerts >
. 131 25 Applications ~ CHNE—— 13 Applications ~ CHNE——
© FortiAl Gen Al Apps . 3 Users — 2 Users ——
o (124 Allowed / 7 Blocked)
Most popular AP @ & Panabee.Hotpot Most popular APP @ [l Udio
B Reports > 6
£ System Settings > Cmillsms
5 = Writing Assistant 6 [ Video Generator
3
12 Applications ~ CNE—— 10 Applications ~ CHEE—
2Users — 3 Users —
. Most popular APP @ [ Al21.LabsWordtune Most popular APP @ [ HeyGen
7 @ Code Assistant 8 E= Enterprise Search
8 Applications o— 1 Applications —
2 Users o— 1 Users —
FATINET w00 Most popular AP~ @ & Anysphere.Cursor Most popular APP @ € Coveo.Al

This dashboard includes the following three widgets:

Widget Description

GEN Al Access Threats This widget displays:
* Number of DLP violations detected.
» Number of threats detected, alerted, and blocked. Indicates if these
numbers are trending up or down.

* Number of sensitive data detections, alerted, and blocked. Indicates if
these numbers are trending up or down.

Gen Al Access Overview Displays the total number of Generative Al applications accessed and total
number of users that used these applications.
This widget also displays the number of blocked and allowed applications
available to the user.

Gen Al Access Categories Displays the generative Al that has been accessed by category.
Applications are grouped in the following categories, which are setin
FortiGuard:

e Conversational Assistant
» Audio Generator

e Code Assistant

» Enterprise Search

¢ Image Generator

» Meeting Assistant

e Productivity Assistant

» Video Generator

» Writing Assistant
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Security Operations (SOC)

Widget Description

Each category displays the total number of users and applications, including
the most accessed application.

The users and applications are divided into two groups: Sanctioned and
Unsanctioned. These attributes are set in the authorized FortiGate devices.

Asset and Identity

This section lists the new features added to FortiAnalyzer for asset and identity:

¢ Improvements to the user experience in the Asset and Identity Center on page 12

Improvements to the user experience in the Asset and
Identity Center

Ly

g This information is also available in the FortiAnalyzer 8.0 Administration Guide:

Asset List

¢ |dentity List

The GUl in Fabric View > Asset Identity Center has been changed in FortiAnalyzer 8.0.0 to improve the admin

user experience.

This includes the following changes in the Asset and Identity List:

(™ eFAZ-240

Dashboards

25 Device Manager
& Fortiview

] Log View

@ Fabric View

Asset Identity Center

Subnets

Incidents & Alerts
© FortiAl
Bl Reports

£¥ System Settings

F=RATINET

= Q- Member ADOM:root >_ @~ L3 © o admin v
Summary EEEERGENIVARSY
@ lastNDays v N= | 60 2025-12-21 16:09:22 - 2026-02-19 16:09:22 3, Create Custom View ‘ ‘ = Data Sources. ‘ ‘ &, Download | ‘ C Reload ‘ Asset v
Top 10 Risky Assets Top 10 Vulnerable Assets
a -1 758 A n-PC «oDCET»
a8 A Y -1 oD e v
= PC2 I A oD =
a PC == 22 a;aE» o
a LTo = C 9
a NB1 4 wm aa
EH 22 Y pC -
w . C A NB1
A vm A Lo
a 18 = PC2
Endpoint Name + User Importance Risk Score s | Vulnerabilities = OT/IoT Vulnerabilities | Tags IPAd(n
-1 L5 Regular Asset 758 e v J
A L3 Regular Asset o » & all_registered_clients  Low
= PC2 B L3 Regular Asset
PC L3 Regular Asset 1
NB1 3 Regular Asset
LTo L3 Regular Asset
- pr—— — rorot i) A frmramd) lamad
Total Selected: 1 100 v /Page 234 5151 0% 100
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Security Operations (SOC)

» Colors are used with certain number fields to help identify severity. For example, see the Top 10 Risky

Assets in the image above.
< Pagination is fixed on the footer of the As

set Identity List.

» The pill shape used in the Asset Identity List, such as in the Vulnerabilities column, is updated to unify with

other elements in the Ul.

e The Top 10 Vulnerable Assets widget does not display low severity vulnerabilities, since this widget is

supposed to focus only on top threats.

It also includes the following changes in the endpoint details:

(™ eFAZ-240 Q-
Dashboards EL

B3 Device Manager

E FortiView

[3Regular Asset  First seen: 2026-01-22 15:31:22 = Last active

] Log View

9 49

[@ Fabric View

16 hours ago

 Critical Vulns High Vulns Nlerts
Asset Identity Center
Subnets
I Incidents & Alerts System Properties
© FortiAl Endpoint ID 1P Address
B Reports
Host Name Device Type
1 endpoint

a System Settings

Detection Key

Vulnerabilities [3

Vulnerability ID % Type % Severity &
25156 Applications EEEEE
25159 Applications EEEEN
25160 Applications EEEEE
25161 Applications EEEEN

FZ:RTINET

First Seen
2026-01-22 15:31:22

Reference %

CVE-2015-4835

CVE-2015-4843

CVE-2015-4844

CVE-2015-4860

Retumn

Member ADOM:root >_ @~ L1 & (@) edmn-

75.8 7102
~—0

Associated Users

MAC Address

Detection Type
By_fctuid
Last Seen

2026-02-19 00:09:40 (16 hours ago)

@ o*

Search

Description &

Supported versions that are affected are Java SE 6u101, Java SE 7u85, Java SE 8u60 and |

Supported versions that are affected are Java SE 6u101, Java SE 7u85, Java SE 860 and |

Supported versions that are affected are Java SE 6u101, Java SE 7u85, Java SE 8u60 and .

Supported versions that are affected are Java SE 6u101, Java SE 7u85, Java SE 8u60 and .

« Afterdrilling down to an endpoint, the detail views now display in full screen.
» The four widgets at the top of the asset details are now colored to better visualize the information: Critical

Vuins, High Vulns, Alerts, and Associated

Users.

» The four widgets at the top are also interactive; click the widget to jump to the related information
within the detail view. For example, click the Associated Users to jump to the Users section in the

details view.

(™ eFAZ-240 Q- Member ADOM:root > @~ L3 © o admin v
@ Dashboards 22 3
22 Device Manager
am 22 allregistered clients  Low  Intemal  QA-Lab
2 Fortiview L[]
[GRegular Asset  First seen: 2025-12-01 11:16:14  Lastactive: an hour ago
M Log View E
@) Fabric View V' it vuns High Vulns Ners s
Asset Identity Center
Subnets
Users (1)
Administrator @administrator Flrst seen Lo >
. ! Dec1,2025 8
© FortiAl
B Reports
Installed Software (133)
£ System Settings Microsoft Exchange Clien... v152.1118.7 Firstseen Last seen nstalled Microsoft Exchange Clien... v15.2.1118.7 First seen Last seen Installed
Microsoft Corporation Dec 1,2025 15:57 3 months ag 2023-09-06 > Microsof ft Corporatic Dec 1, 2025 15:57 3 months ago 2023-09-06 >
Microsoft Unified Commun... v5.0.8308.0 First seen Last seen Installed 1IS URL Rewrite Module 2 v7.2.1993 Last seen Installed
Microsoft Corporation Dec 1,2025 15:57 3 months ag 2012-09-08 > Microsoft Corporation Dec 1, 2025 15:57 3 months ago 2023-09-06 >
Microsoft Exchange 200... v3.3.4604.600 First ses st Installed Microsoft Exchange 200... v3.3.4604.001 Fig Last seen Installed
Microsoft Corporation Dec 1,2025 15:57 months age 2023-09-06 > Microsoft Corporation Dec 1, 2025 15:57 3 months ago 2023-09-06 >
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Security Operations (SOC)

» The header information in the endpoint details, including the four widgets (Critical Vulns, High Vulns, Alerts,
and Associated Users), is now fixed to the top so the user always sees key information as they scroll further

down.

< The container heights have been increased to ensure more visibility, allowing the tables within containers to
display at least six rows. For example, see the Related Alerts table below.

(™ eFAZ240
Dashboards

23 Device Manager
&2 Fortiview

[ Log View

@ Fabric View

Asset Identity Center

Subnets

B9 incidents & Alerts

@ Fortial
B Reports

£ System Settings

F::RTINET

am PC1

L3 Regular Asset  First seen: 2026-01-23 23:49:11 « Last active: 2 minutes ago

90

~ Critical Vulns

High Vulns

First Seen
2026-01-23 23:49:11

Source
FG3K root.
Related Alerts
Severity % Last Occurr... 5
20 minutes ago
40 minutes ago
Critical an hour ago
High an hour ago
High an hour ago
an hour ago
Users (1)

Last Seen
2026-02-19 16:02:18 (2 minutes ago)

Aert &

High bandwidth endpoint PC1 detected
High bandwidth endpoint PC1 detected
High bandwidth endpoint PC1 detected
Incoming Intrusion to PC1 detected
Internal intrusion TCPOverlapping Fragments detected

High bandwidth endpoint PC1 detected

Member ADOM:root >- @~ L3 O (@) admin~

Nerts

Retun

Associated Users

Search @ >

12% 13

Search

» The Users and Installed Software sections of the detail views now display in a split view, saving space while
maintaining visibility and organization.

(® eFAZ240
Dashboards

23 Device Manager
&2 Fortiview

[ Log View

@ Fabric View

Asset Identity Center

Subnets

3 Incidents & Alerts
© FortiAl
B Reports

¥ System Settings

F::RTINET

LT

am LT

LGRegular Asset  First seen: 2026-01-21 11:58:28 » Last active: 9 minutes ago

90

~ Critical Vulns

Member

ADOM:root  >_

@ 0> S @emin-

High Vulns Alerts Associated Users
Users (2) Search
Score First seen Score First seen

/100 Oct 27,2025 /100 Jan 21,2026 >
Installed Software (262) Search
Dell OS Recovery Tool v2.4.1.2181 First seen Last seen Installed Microsoft NET Host FX ... v64.92.45415 First seen Last seen Installed
Dell Jan 21,2026 12:47 16 hours ago 20250109 Microsoft Corporation Jan 21,2026 12:47 3 days ago 20260120 >
Microsoft Office Shar... v16.0.4266.1001 First seen Last seen Installed Microsoft Store  v22511.1401.6.0 First seen Last seen Installed
Microsoft Corporation Jan 21,2026 12:47 2 days ago 20250415 Microsoft Corporation Jan 21,2026 12:47 amonth ago 20260113 >
NVIDIA Control Panel v8.1.969.0 First seen Last seen Installed Windows Calculator 11250840 First seen Last seen Installed
NVIDIA Corp. Jan 21,2026 12:47 16 hours ago 20251106 Microsoft Corporation Jan 21,2026 12:47 16 hours ago 20251210 >
Windows Feature E... v1000.26100.28.0 First seen Installed ms-resource:Resources/... v11.2510.14.0 First seen Installed
Microsoft Windows Jan 21,2026 12:47 20251216 Microsoft Corporation Jan 21,2026 12:47 20260114 >
Microsoft Office Stan... v16.0.4266.1001 First seen Last seen Installed DisplayLink Manager v3.2.14.0 First seen Last seen Installed
Microsoft Corporation Jan 21,2026 12:47 2days ago 20260217 DisplayLink Jan 21,2026 12:47 16 hours ago 20231102 >
Game Bar 17.325.110610 First seen Last seen Installed Intel(R) Wireless Bluetooth(R) v24.0.11  First seen Last seen Installed
Microsoft Corporation Jan 21,2026 12:47 16 hours ago 20251123 Intel Corporation Jan 21,2026 12:47 2days ago 20251218 >

Retun

* The search tools in the details view, such as in the Users and Installed Software sections, will find and
highlight the information for fast navigation.
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Security Operations (SOC)

(W eFAZ-240 Q

Member ADOM:root >~ @~ L3 © oadmm,
@ Dashboards 1T

2 Device Ma

sl T
L]

L3 Regular Asset  First seen: 2026-01-21 11:58:28 » Last active: 10 minutes ago

0

@ Fabric View Critical Vulns High Vulns Nerts Associated Users
Asset Identity Center
Subnets 23 minutes ago | High bandwidth endpoint LT1 detected
anhourago | High bandwidth endpoint LT1 detected
[ incidents & Alerts
2hoursago | High bandwidth endpoint LT1 detected
© FortiAl 2hoursage | High bandwidth endpoint LT1 detected
2hoursago | High bandwidth endpoint LTt detected
orts
I |Ferorts vigh 2hoursage Intnson Tacerote deteced
£ System Settings 0% 8
Users (1) ma
. Score First seen Last seen
@ma N
. 7100 Jan 21,2026 3 hours ago
Installed Software (262) Dell 0OS
Del OS Recovery Tool v2.4.1.2181 First seen Last seen Installed
Dell Jan 21,2026 12:47 16 hours ago 20250109 ’

F:RTINET Retum

» Tooltips now display in the color opposite of the color mode used by the interface, ensuring they are easily
visible. Note that tooltip appearance delay is 300ms.

(™ eFAZ240 Q-

Member ADOM:root >_ @+ L3 O () admin~

Dashboards 1

2 Device Ma

LG Regular Asset  First seen: 2026-01-22 15:31:22 » Last active: 16 hours ago

949

@ Fabric View Critical Vulns High Vulns Alerts. Associated Users.
Asset |dentity Center
Subnets
Detection Key First Seen

Supported versions that are affected are Java SE 6u101, Java SE 7u85, Java SE
I Incidents & Alerts 2026-01-2215:31:22 8u60 and Java SE Embedded 8u51. Easily exploitable vulnerability allows
successful unauthenticated network attacks via multiple protocols. Successful
attack of this vulnerability can result in unauthorized Operating System takeover

© FortiAl - including arbitrary code execution. Note: Applies to client deployment of Java
Vulnerabilities 3 only. This vulnerability can be exploited only through sandboxed Java Web Start
applications and sandboxed Java applets.
B Reports Vulnerabilty 1D = Type Severity & Reference =
£ System Settings 25156 Applications CVE-2015-4835 Sum@led versions that are affected are Java SE 6u101, Java SE 7u85, Java SE 8u60 and |
25159 Applications CVE-2015-4843 Supported versions that are affected are Java SE 6u101, Java SE 7u85, Java SE 8u60 and .
25160 Applications CVE-2015-4844 Supported versions that are affected are Java SE 6u101, Java SE 7u85, Java SE 8ué0 and .
25161 Applications CVE-2015-4860 Supported versions that are affected are Java SE 6u101, Java SE 7u85, Java SE 8ué0 and .
25277 Applications CVE-2015-2628 Supported versions that are affected are Java SE 6u®5, Java SE 7u80, Java SE 8u45, Java ¢
0% 291

Others

This section lists the new features added to FortiAnalyzer for other topics related to security operations:

« FortiMQ connector for automated blocking on page 16
e Machine learning for anomaly detection on page 21
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FortiMQ connector for automated blocking

Ly

g This information is also available in the FortiAnalyzer 8.0 Administration Guide:

* Connector actions > FortiMQ Connector

¢ Blocking indicators

The FortiMQ Connector is introduced in FortiAnalyzer 8.0.0. This connector enables direct transmission of

blocked indicators to FortiGate devices.

Previously, block lists could only be distributed to FortiGate devices using the FortiManager connector. This
new feature provides an alternative and allows you to block indicators even without a FortiManager deployed in

your environment.

To enable the transmission of block lists from FortiAnalyzer to FortiGate, you must complete the following:

< Enable logging from the FortiGate devices to FortiAnalyzer. For more information, see the FortiAnalyzer
Administration Guide and the FortiGate/FortiOS Administration Guide.

» Verify that both FortiAnalyzer and FortiGate are registered under the same FortiCare account to allow
proper communication and integration.

» Enable and configure Cloud-based Fabric Feed synchronization on FortiGate to consume and enforce the
block indicators received. For more information, see the FortiGate / FortiOS 8.0 New Features Guide.

< Enable the FortiMQ Connector in FortiAnalyzer.

The steps below assume the admin has already completed the first three requirements listed above. In these

steps, they will enable and use the FortiMQ connector.

To use the FortiMQ connector:

1. GotolIncidents & Alerts > Automation > Active Connectors, and enable the FortiMQ Connector.
ADOM:roct >— @~ A3 © oadmi,.v

@ Dashboards

Summary EETCICHUEEUEN Playbook | Playbook Monitor

A Warning: Image is not Certified

&3 Device Manager

Fortinet Connectors (12)

Fort

M Log View

@ Fabric View

[ Incidents & Alerts

Incidents
Alerts
Alert Handlers

llectors

FortiGuard Services
Automation

Log Parsers

& FortiAl
B Reports

¥ System Settings

The FortiMQ connector is available and disabled by default in all Fabric and FortiGate-type ADOMs.

FortiOS Connector

Connector to FortioS.
operations

Fortios

52 evices connected
¥ 0 devices disconnected

[e )

Third Party Connectors (4)

Local Connector
The Local Connector
facilitates communication

and data exchange
between FortiAnalyzer and

LOCALHOST
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FortiGuard Connector
Provides connectivity to
FortiGuard services for

accessing real-time threat
intelligence feeds, security

FortiGuard

FortiMQ Connector
Enables integration with l
FortiMQ to facilitate the

automated distribution of
IP, MAC, Domain and URL

FortiMQ

VirusTotal Connector

VirusTotal Premium
Services are used to get

FortiManager Connect...
Using this connector
establishes a Fabric
Connection to
FortiManager Device,

(+]

FortiManager

© (o]
(o] (o]

VSphere Connector

Provides connectivity to
VMware vCenter and ESXi
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When enabled, this connector automatically establishes a connection to the FortiMQ cloud service; no
additional configuration is required. The connector status reflects its health, indicating whether the API
connection is successful.

"@" You cannot create new FortiMQ connectors or delete the existing one in the ADOM.

2. After confirming the connector is active, go to Incidents & Alerts > Indicators to block/unblock indicators.
Indicators can also be blocked from Incidents and, as of 8.0.0, from Log View as well.
3. Select anindicator and click Block.

Mousing over the Block button displays the tooltip: “Block/Unblock will be carried out by FortiMQ

connector.”
(™ FAZVM64 Q ~ ADOM:root >— @~ L3 & °admmv

A Warning: Image is not Certified

Indicator Type Reputation Enrichment Sta... Block Status
mP mTED M None 3 W Unblocked 4
@ Domain ‘ 5 B Malicious B Completed 2  None 1

@ Dashboards

mURL B Good W InProcess o 5
| Mac m Suspicious B Failed 0
W NoReputatio..

comnmw
[t

[ Log View

@ Fabric View

F2 incidents & Al @ Block | | €© Show Charts ¥ Searcl @ -~
¥ incidents lerts

Block/Unblock will be carried out by FortiMQ connector.

neident @ | Indicator Type & Block Status & Delivery Channel & Rating Confidence & Reputation & Enrichment Status + Source % u
ncidents
Alerts Domain Unblocked FortiMQ mmEm Completed admin
Alert Handlers P Unblocked FortiMQ admin
acicoleoon a1 P Unblocked FortiMQ admin
Indicators . -
vpn.com Domain admin
FortiGuard Services
3 Unblocked FortiMQ [T Good Completed admin
Log Parsers
© FortiAl
B Reports
#F System Settings
Fi:RTINET 1000 /Page

Ly

‘@ When both FortiManager and FortiMQ connectors are available, blocking via FortiManager
remains supported. However, priority is given to the FortiMQ connector. Indicators are sent via
FortiManager only if the FortiMQ connector is disabled.

Below is an example where the above selected IP/domain are accessible from an endpoint before they were
blocked:

FortiAnalyzer 8.0.0 New Features Guide
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Activities [ Terminal 5 2 L) O~

-virtual-machine: ~

File Edit View Search Terminal Tabs Help

Termina, Nitetmadine s ] ke RO

-virtual-machine:~$ ping cyberghostvpn.com
PING vpn.com ( 12) 56(84) bytes of data.
64 bytes from 12 ( 12): icmp_seq=1 ttl=54 time=1.42 ms
64 bytes from 12 ( 12): icmp_seq=2 ttl=54 time=1.27 ms
64 bytes from 12 ( 12): icmp_seq=3 ttl=54 time=1.17 ms
AC
vpn.com ping statistics ---
3 packets transmitted, 3 received, 0% packet loss, time 2002ms
rtt min/avg/max/mdev = 1.177/1.290/1.420/0.099 ms

-virtual-machine:~$

B
=]
<
=
B
A
e
a3
3

Upon confirming a Block or Unblock action, the “block_indicator” playbook runs in the background and
sends the indicators to FortiMQ. See below for an example of blocked indicators in FortiAnalyzer:

(™ FazvMss ADOM:root >— @~ A3 O oa“"‘""
@ Dashboards A Warning: Image is not Certified

Indicator Type Reputation Envichment Sta... Block Status
&3 Device Manager 7;) [ — R —— [
miP 4 mTBD 4 W None 4 M Blocked 3
 Eortiview @ Domain 2 W Malicious 1 mCompleted 2 B Unblocked
FortiView 3 BORL o 6 B Good B 6 Hibrocess 0 6
B Mac o I Suspicious o M Failed o
M Log View B NoReputatio... o
@ Fabric View
© Show Charts v Se @ -

[ Incidents & Alerts

ncident O | Indicator Type Block Status & Delivery Channel + Rating Confidence & Reputation & Enrichment Status & Source & u

ncidents

Alerts o 11 P Blocked FortiMQ admin

Alert Handlers [u] vpn.com Dormain Blocked FortiMQ admin

Alert Collectors o 12 13 Blocked FortiMQ admin

Indicate

neicators: o Domain Unblocked FortiMQ mmEm [~ Malicious | Completed admin

FortiGuard Services

o P Unblocked FortiMQ admin
Automation
Log Parsers [m] P Unblocked FortiMQ EEEE | Good | Completed admin
FERATINET 00 1000 v /Page

FortiGate retrieves these indicators from FortiMQ and updates them in the external feeds. These feeds can
then be used in policies or profiles to deny access. External feeds are updated on FortiGate with the
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indicators sent from FortiAnalyzer:

04TM25! - = Q-

@ interimbuild0162 ~

=3

A Installed firmware is not signed by Fortinet

1P Address External Feed IP_Blocked_by_Fabric_SecOps

(& comenen) 4

@ admin ~

x

] @ Accepted

ERIEEE [ search fitterable columns
Entry Validity Comments
[m] 11 © Valid
12 © Valid

IP_Blocked_by._F¢

External Connectors

enter

2

FATINET v ‘mware Upgrade (1 device(s)

@ interim build0162 ~

A Installed firmware is not signed by Fortinet

@ admin +

] @ Accepted

Entry Validity Comments

(] vpn.com @ Valid
Blocked |P Address Fz|

1P_Blocked_by_Fi
System

) Security Fabric

External Connectors

enter

1

FRATINET . 3 Firmware Upgrade (1 device(s))

The policy in this example was setup to deny access to the above threat feeds. See below for the ping
results:
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Activities ] Terminal ~

S
-
<
o
=
A
®
B
-y

Ly

PING vpn.com (
e

PING vpn.com (
AC

PING 12 (
AC

File Edit View Search Terminal Tabs Help

2 ~virtual-machine: ~

-virtual-machine: ~

vpn.com ping statistics ---

3 pa(ketsztransmitted, 3 received, 0%
rtt min/avg/max/mdev = 1.177/1.290/1.420/0.099 ms

-virtual-machine:~$
-virtual-machine:~$
-virtual-machine:~$ ping |

packet loss, time 2002ms

vpn.com

.11) 56(84) bytes of data.

vpn.com ping statistics ---

-virtual-machine:~$ ping

-virtual-machine:~$ ping

12 ping statistics ---

-virtual-machine:~$§ I

9 packets transmitted, 0 received, 100% packet loss, time 8198ms

vpn.com

.11) 56(84) bytes of data.

--- vpn.com ping statistics ---
4 packets transmitted, © received, 100% packet loss, time 3077ms

12

12) 56(84) bytes of data.

3 packets transmitted, 0 received, 100% packet loss, time 2048ms

x virtual-machine: ~ * R

'@ Unlike FortiManager, which operates at a global level, FortiMQ is ADOM-specific. Blocked
indicators are applied only to FortiGate devices within the same FortiAnalyzer ADOM.

In FortiAnalyzer 8.0.0, a new type of indicator known as "Mac" can be created and blocked and unblocked to

both FortiManager and
(™ Fazvmes

@ Dashboards

28 Device Manager

FortiView

MM Log View

@ Fabric View

[ incidents & Alerts

Incidents
Alerts

Alert Handlers
Alert Collectors

Indicators

FortiGate.
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Create New Indicator

Indicator

Indicator Value®

ADOM:root >_ @~ A3 © °admmv

Domain

Mac
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To block indicators from Log View:

1. GotoLog View.

2. Right-click the value in the table, such as a malicious IP or domain, and select Create indicator and block.

(™ FAzZvM64 ADOM:root >— @~ N3 O oadminv

@ Dashboards A Waming: Image is not Certified

(1] o
® B B & ¢ & g & @ 0 8 B B % @ 4 ® 4
FortiGate
View More v/
Traffic Security v Event v
AllDevicesv @ Last1 Hour v 15:16:16 - 16:16:16 | L3 Full Screen| [ % Create Custom View ] [ @ Refresh | [ § More ~
.

# Date/Time Device ID Action Source User Destination IP Service Application Sent/Received
© FortiAl

2026-04-1316:15:45 | FGVMO4TM v HTTPS 1 SSL_TLSv1.3 19 KB/15 KB
B Reports 2026-04-1316:1532  FGVMSLTM: v RSH RSH 60.0B/0.0KB |
T — 2026-04-1316:1520  FGVMO4TM v 16 HTTPS HTTPS 7.7 KB/10.2KB I
ystem Settings
2026-04-1316:1520 | FGVMO4TM v @ Add AND Filter "Destination IP = 16" 7.7 KB/102 KB I
2026-04-1316:15:147  FGVMSLTM: v & Add AND Filter "Destination IP 1= 16" 55KB/9.2KB 1
2026-04-1316:15:17  FGVMSLTM v @ Add OR Fiter "Destination IP = 16 300.0B/00KB |
@ Add OR Filter "Destination IP 1= 16"
2026-04-1316:15:17  FGUMSLTM: v 6.7KB/12.0KB I
Q Replace with Filter "Destination IP = 16"
2026-04-1316:15:10  FGVMSLTM: v 7.3KB/10.6KE I
Q Replace with Fiter "Destination IP 1= 16"
2026-04-1316:1507 | FGVMSLTM: v A Create Indicator and Block Egistratior 118.9 KB/84.4 KB mmm
2026-04-1316:1507  FGVMSLTM: v DN DN 418.08/21608
2026-04-1316:1507  FGVMSLTM: Q@ IP connecti DNs DNs 0B/0B
2026-04-1316:1422  FGUMSLTM: v RSH RSH 7.3KB/10.6KB I
2026-04-1316:14:10 | FGVMO4TM v DNs DNs 345.0B/839.08
2026-04-1316:1345 | FGVMO4TM v HTTPS 15 SSL_TLSv12 74KB/73KB 1

Total logs for analysis: 17 days 5 hours 50 ~ /Page II 2| 3| 4|5 |»| A067seconds
You can also right-click the value in the log details view to access this action in the shortcut menu.
Supported field types for blocking indicators include:

° 1p
e url
e domain

e mac-address

This action adds a new indicator and blocks it automatically.

Machine learning for anomaly detection

e

g This information is also available in the FortiAnalyzer 8.0 Administration Guide:
« Machine learning for anomaly detection

security effy

FortiAnalyzer 8.0.0 introduces a feature utilizing machine learning models to analyze historical log data and

establish a unique behavioral profile for every user. This feature automates the detection of zero-day threats
and insider threats that do not follow known attack signatures. It solves the issue of alert fatigue by reducing
noise from static rules. It also addresses the detection gap by identifying account takeovers (unusual login
times/locations) and data exfiltration (abnormal upload volumes) that would otherwise go unnoticed under
traditional security policies.

As of 8.0.0, this feature supports the generation of anomaly alerts for the following scenarios:

» FortiAuthenticator Login Anomalies: Detects unusual login activities based on geographical location and
time deviations.

FortiAnalyzer 8.0.0 New Features Guide
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 FortiGate Traffic Anomalies: Detects excessive or abnormal inbound and outbound traffic patterns, helping
to identify potential data exfiltration or compromised hosts.

Before configuring this feature on your FortiAnalyzer, it is recommended to get familiar with the following
machine learning components:

* Model: The core machine learning algorithm designed for a specific task (for example, login anomaly or
traffic download anomaly).

» Asset: A specific entity being monitored, such as an enduser or an endpoint device.

« Artifact: The finalized, trained model data generated after processing historical logs. This artifact is what
the system actively uses to perform real-time inference and detect anomalies.

To utilize the Machine Learning Anomaly Detection feature, you must enable the machine learning engine
globally and configure the specific models to establish a training schedule.

The feature is managed in the FortiAnalyzer CLI. Enabling the machine learning flow (m1flow) initiates the
creation of required materialized views (MVs) in the backend database.

Enabling the machine learning engine and configuring models

In the FortiAnalyzer CLI, enable and configure the machine learning flow (config system mlflow).

This includes setting the training schedule, defining the historical data period (train-data-days), and enabling
automatic deployment of the trained artifact. See the example below.

config system mlflow
set status enable
config models
edit 1

set status enable
set model-type login-anomaly
set artifact-max-count 10
set artifact-retention 30
set asset-max-count 10000
set train-data-days 90
set train-repeat-at 7d’
set train-test-days 7
set auto-deploy enable

set inference-interval 20

FortiAnalyzer 8.0.0 New Features Guide
Fortinet Inc.

22



Security Operations (SOC)

next
end
end

Variable descriptions:

Variable Description

status {enable | disable} Default disable, enable to allow training and inference of miflow related
logic for a specific model.

model-type {login-anomaly | Only one of each model-type allowed in config.
traffic-download-anomaly |
traffic-upload-anomaly}

train-schedule-range <string> Use system timezone. Start scheduled training after the start time. End
scheduled training after end time.

Training schedule range formats:
e Continuous training: 'YYYY-MM-DD HH:MM'

For example: '2025-01-01 00:00'
e Boundedrange: 'YYYY-MM-DD HH:MM -- YYYY-MM-DD HH:MM'
For example: '2025-01-01 00:00 -- 2026-01-01 00:00'
Default: Start from current time (continuous).

train-repeat-at <string> Training repeat schedule formats:
e Daily: 'Daily HH:MM'
For example: 'Daily ©2:00'
o Weekly: '"Weekly <Day> HH:MM'
For example: 'Weekly Monday ©2:00"' or 'Weekly Mon ©2:00'
e Monthly (day of month): '‘Monthly <DD> HH:MM'
For example: 'Monthly 15 ©2:00"' (15th of each month)
e Monthly (nth weekday): 'Monthly <N> <Day> HH:MM'
For example: 'Monthly 3 Monday ©2:00' (3rd Monday of each month)
e Interval: "<N>d"
For example: '7d' (every 7 days)
Default: 7d (train every 7 days since the start time of train-schedule-range).

train-data-days <integer> Number of days of historical data to use for model training. More training
data generally improves model accuracy but increases training time and
resource usage (1- 365, default = 90).

train-test-days <integer> Number of days used for testing the trained model. Must be less than or
equal to train-data-days (1- 90, default = 7).
During testing, assets that fail to meet the sensitivity criteria are added to
the exclusion list.

train-test-sensitivity {high | Training test sensitivity.
low | medium} * high: High sensitivity. Uses strict criteria during testing, more assets in

FortiAnalyzer 8.0.0 New Features Guide
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Variable Description

exclusion list.

» low: Low sensitivity. Uses lenient criteria during testing, fewer assets in
exclusion list.

» medium: Medium sensitivity. Balanced testing criteria, moderate asset in
exclusion list.

asset-max-count <integer> Maximum number of assets to track. Assets include endusers and
endpoints depending on the model type. Higher values require more
memory and processing resources (100 - 100000, default = 1000).

auto-deploy {enable | disable}  Deploy artifact automatically when model is trained on schedule.

If this is disabled, see Manually training the machine learning models and
validating artifacts on page 26 to manually deploy the artifact.

inference-interval <integer> Inference interval in minutes (1 - 1440, default = 20).

Defines how frequently the model analyzes new data for anomalies. Shorter
intervals provide faster detection but use more resources.

Recommended values by model type:
* login-anomaly: 20 minutes
« traffic-download-anomaly: 60 minutes (must be multiple of 60)
« traffic-upload-anomaly: 60 minutes (must be multiple of 60)

0y

‘@ Traffic models require inference-interval to be a multiple of 60.

artifact-retention <integer> Artifact retention period in days (1 - 365, default = 30).

Artifacts older than this period are automatically deleted. The most recent
artifact-max-count artifacts are always retained regardless of age.

artifact-max-count <integer> Maximum number of artifacts to retain per model (1 - 100, default = 10).

Older artifacts beyond this count are deleted automatically. This limit is
enforced regardless of artifact-retention setting.

See below for an example miflow configured in the FortiAnalyzer CLI:

ADOM:root > @~ L2 &

W@ [iMorey = O x
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Monitoring the lifecycle of the machine learning models

You can use the diagnose mlflow commands to monitor the lifecycle of the machine learning models from
training progress to artifact deployment.

Command Description

diagnose miflow config Show per-model config and artifact stats (count, deployed, last trained).
diagnose miflow infer-result Display latest inference results for an artifact.

<artifact_name> Enter the name of the artifact (for example, 2025123110000050100).

diagnose miflow list-artifacts List all trained artifacts.

<arg0> Optional filters: status=<val>, model_type=<val>, artifact_name=<val>.
For example: status=deployed model type=login-anomaly artifact_
name=<name>

diagnose miflow show-assets  List assets trained and excluded for the artifact.

<artifact_name> Enter the name of the artifact (for example, 2025123110000050100).
diagnose miflow show-details  Show detailed information about a specific artifact.
<artifact_name> Enter the name of the artifact (for example, 2025123110000050100).
diagnose miflow test-result Display latest test results for an artifact.

<artifact_name> Enter the name of the artifact (for example, 2025123110000050100).
diagnose miflow training- Show current training progress for models in training.

status

See below for examples of the diagnose mlflow outputs:

diagnose miflow list... W m@® L | IMorev| - B x I

mlflow list-artifacts

FortiAnalyzer 8.0.0 New Features Guide
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Em@ [ivoe|—8 x |

diagnose miflow conf...

AZVME4-51cbbBde ¥ diagno

MLflow System Status

uploa

nabled:
Buto-Deploy:

§ Morev | —

me s

FAZVME4-51cbbS,
cartifact_name>
FAZVME4-51cbb8)
a3, s 9, "sent": 504
ved o 1 hlah:x than predicted peal
504323 affic_observed human": "48.10 MB"

ecv": 9730614, "sent": 9730614,
o 12 hlﬂh:l' than predicted peak
rved_human”:
28124179, "sent": 28124179,
B i higher than predicted peak 2
N

1101
‘(pl:n:tlrn 00 on Thu
maly hour ¢
| Meuid! ov
tzaffic cboerved at endpoint 6. 1‘ MB is mqh
ic_cbserved bytes": €4 raffic_ol L]
9207, “type!
ic observed at endpoint 1 than pl:dl\_ted peak
baerved byte:

4
2026-0 2.21 mn 15 higher than predicted peak g
"t
. "sent
51.20 ua is higher than pmdl_md p&

explanation g
nomaly_hour_end”
pid , “eui

t endpoint

Manually training the machine learning models and validating artifacts

You can use the execute mlflow commands to manually train the machine learning models, exclude assets, and

validate artifacts.
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Command Description

execute miflow cancel Cancel artifact training.
<artifact_name>

execute miflow delete Permanently delete artifact.
<artifact_name>

execute miflow deploy Deploy artifact for active inference.
<artifact_name>

execute miflow exclusion-list Manage ML exclusion-lists.
{artifact | model} {add | list | e artifact: Artifact-level exclusion-list operations.

remove} <asset>  add: Add asset to artifact exclusion-list.
e list: List exclusion-listed assets for artifact.
* remove: Remove asset from artifact exclusion-list.
* model: Model-level exclusion-list operations.
¢ add: Add asset to model exclusion-list.
e list: List exclusion-listed assets for model type.
¢ remove: Remove asset from model exclusion-list.

execute miflow test <artifact_  Test/validate artifact on specified time range.

name> <start_time> <end_ e <start_time> <end_time>: Start time and end time can be entered in
time> the following format: YYYY-MM-DD HH:MM.

execute miflow train <model_ Train the machine learning model on specified time range.

type> <start_time> <end_ e <model_type>: Model type includes login-anomaly, traffic-

time> [train-assets-limit] download-anomaly, traffic-upload-anomaly.

e <start_time> <end_time>: Start time and end time can be entered in
the following format: YYYY-MM-DD HH:MM.

e [train-assets-1limit]: Optionally, set the maximum number of assets
to train (1-100000).

Example:
execute mlflow train login-anomaly '2026-02-05' '2026-05-05'

execute miflow undeploy Undeploy artifact from active inference.
<artifact_name>

Alert Handler: Machine Learning Based Anomalous Activity
Detection

The internal inference events are automatically processed by the predefined alert handler named Machine
Learning Based Anomalous Activity Detection.
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FAZVMé4-51cbb8de

ards

B3 Incidents & Alerts

Incidents

Alert Handlers

F::ATINET

ADOM:root >~ @~ L2 & °aummv

Edit Basic Alert Handler x
Status ©
Name* fac
Descriodon Uses machine leaming to identify abnormal activities and potential threats
Y
76/1024
MITRE Tech ID Click to select
Data Selector Click to select -
Automation Stitch o
Automatically Create o]
Incident
Rules.
Status Name
© Geolocation Based Anomalous Login Detection ]
© Anomalous Upload Traffic Usage Detection ®
© Anomalous Download Traffic Usage Detection ®
© Anomalous Upload Traffic Relative To Expected Baseline Detection ]
© Anomalous Download Traffic Relative To Expected Baseline Detection ®
Add New
Settings
Notifications Click to select -

Factory Roset Carce

Once triggered, an alert is generated, providing the analyst with context regarding the deviation. For example,
an alert highlighting that an upload volume exceeded the user's specific 90-day behavioral pattern.

The alerts can be found in Incidents & Alerts > Alerts > All Alerts; filter by the triggered alert handler (Machine
Learning Based Anomalous Activity Detection).

B FAZVM64-51cbb8de

FATINET

Click the alerts to view their details. See examples below.

Q- ADOM:root >— @+ L2 & ° admin v
Explorer WAVVSSM By Endpoint | By Threat | System Events | Toggle Views O
All Devicesv @ Last 1 Week v 2026-04-16 12:39:54 - 2026-04-23 12:39:54 Show Acknowledged Show External * Expand All & Refresh v &
triggername="Machine Learning Based Anomalous Activity Detection" AND handler_type="basic" x Q
O Alert Alert Sta... £ | Alert Type & Co.. 4 | Severity2 | Suppress# | Outbreak Name % First Occurrence + Last Update % Additional |nfcn
(] Unhandled | ml_upload_traffic_anomaly 7 ®High 13 hours ago 5 hours ago Endpoint’

(] Unhandled | mi_upload_traffic_anomaly 10 ®High 13 hours ago 4 hours ago Endpoint’
(] Unhandled | mi_upload_traffic_anomaly 5 ®High 2daysago 2 days ago Endpoint’
(] Unhandled | mi_upload_traffic_anomaly 5 ®High 3daysago 2 days ago Endpoint
(] Unhandled | mi_upload_traffic_anomaly 5 ®High 3days ago 2 days ago Endpoint’
[m] Unhandled  ml_download_traffic_anomaly 7 @ High 3days ago 2 days ago Endpoint’
(m] Unhandled | mi_upload_traffic_anomaly 5 ®High 3daysago 3 days ago Endpoint’
(] Unhandled  ml_download_traffic_anomaly 19 ®High 5 days ago 2 days ago Endpoint’
[m} (6] Unhandled  mi_download_traffic_anomaly 14 ®High 3daysago 2 days ago Endpoint’
(] Unhandled | mi_upload._traffic_anomaly 7 ®High 4daysago 3 days ago Endpoint’ |
(] Unhandled | mi_upload_traffic_anomaly 5 ®High 4 daysago 3 days ago Endpoint
(] Unhandled | mi_upload_traffic_anomaly 10 ®High 4 days ago 3 days ago Endpoint’
[m] Unhandled | ml_login_anomaly < ®High 3days ago 3 days ago User has
[m} ) Unhandled | mi_login_anomaly 2 ®High 3daysago 3 days ago User ash
(] Unhandled  ml_login_anomaly 13 ®High 3daysago 3 days ago User uh
(] Unhandled  ml_login_anomaly 1 ®High 3daysago 3 days ago User has
(] Unhandled | mi_upload_traffic_anomaly 75 ®High 8daysago 3 days ago
(] Unhandled ... 15 ®High 5 days ago 4 days ago
0% 107
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Example: Anomalous upload traffic usage

FAZVM64-51cbb8de
@ Dashboards

3 Device M

FortiVi

[ Log View

@ Fabric View

Incidents & Alerts

Incidents

Alerts

Alert Handlers
Alert Collectors
Indicators
FortiGuard Servic

Automation

© Fo
B Reports
£ System Setti

RTINET

FAZVM64-51chb8de

@ Dashboards

@ Fabric View

Incidents & Alerts

Incidents
Alerts

Alert Handlers
Alert Collectors
Ind

FortiGuard Sel
Automation

Le

' FortiAl

B Reports

ATINET

Anomalous upload traffic usage detected for endpoint: L0

Default By Endgaint

traffie  ml_snomaly_detect

PR occers Locs

Formatted View JREWNE{N]

Alert Time :
Update Time :

Last Log Time :
First Log Time :

Rule Information

4/23/2026, 7:07:49 AM
4/23/2026, 8:07:59 AM
4/23/2026, 6:00:00 AM
4/23/2026, 12:00:00 AM

AlertID:
Alert Type
Severity :

202604231000000002
ml_upload_traffic_anomaly

High

N: o eadmlnv

Rule Name : Anomalous Upload Traffic Usage Detection Alert Handler Name : Machine Learning Based Anomalous Activity Detection
Handler Type basic Device Type SIEM
Log Type : siem Acknowledged no
Acknowledged Time  N/A Log Count : 7
Automation Stitch:  no Suppressed : no
Endpoint
Endpoint : LT0) Endpoint Name : 170
Endpoint IP : Endpoint User ID : 1566
Endpoint ID : 3214 Dest. User ID : 0
Dest. ID 0
MITRE
Alert Details
Je ELQYIETE Table View
Weekly Bandwidth Per Hour
Q' ADOM:roct >_ @~ N2 & °admlnv
Anomalous upload traffic usage detected for endpoint: 1T = £
Defat By Endpoint s anomay_dect
Triggering Logs
- - - I———— cror
Endpoint IP: 158 Endpoint User ID : 1566
Endpoint ID : 3214 Dest. User ID : 0
Dest. ID: 0
MITRE
Alert Details
Ghart View BEEAYEY
Weekly Bandwidth Per Hour
h Fri.00:00:00 521000000 Sun. 00:00:00 Mon. 00:00:00 Tue. 0000:00 Wed. 00:00:00 Thu. 00:00:00
Upload
Rule Summary
When (Threshold 1440 minutes G S
Duration) :
Description : data_sourcetype="FortiGate' and event_type="traffic’ Pattern : IF ML_ANOMALY_OUTBOUND_TRAFFIC(*)>=5

FortiAnalyzer 8.0.0 New Features Guide

Fortinet Inc.

FILTER data_sourcetype="FortiGate’ and event_type="traffic’
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Click the table view to display the information in text format:

B FAZVMé4-51cbbBde
@ Dashboards
38 Device Manager

B Fortiview

[ Log View

@ Fabric View

Incidents & Alerts
Incidents

Alerts

Alert Handlers
Alert Collectors
Indicators
FortiGuard Serv
Automation

Log Parsers

FORTINET

Example: Anomalous download traffic usage

(™ FAZVMBA-51cbbsde
@ Dashboards

&= De

FortiV

[ Log View

@ Fabric View

¥ incidents &Alerts

Incidents

Alerts

Alert Handlers

Al

Indicators
FortiGuard Services

Automation

© Fortial

B Report:

# System Settings

ATINET

Anomalous upload traffic usage detected for endpoint: 170

Default By Endpoint  uraific  mi_anomaly_ detect

PIRERTNY Triggering Logs

Croy
Endpoint IP: 158

Endpoint ID : 3214

Dest. ID o

MITRE

Alert Details

»* Collapse All

8 12:00 am to 1:00 am, Thu 2026-04-23

During 0:00 to 1:00 on Thu 2026-04-23, the outgoing traffic observed at endpoint 9.72 MB is higher than predicted peak 2.56 MB based on historical data from 2026-04-02 to 2026-04-16

@ 1:00 am to 2:00 am, Thu 2026-04-23

During 1:00 to 2:00 on Thu 2026-04-23, the outgoing traffic observed at endpoint 10.07 MB is higher than predicted peak 2.55 MB based on historical data from 2026-04-02 to 2026-04-16

8 2:00 am to 3:00 am, Thu 2026-04-23

During 2:00 to 3:00 on Thu 2026-04-23, the outgoing traffic observed at endpoint 9.71 MB is higher than predicted peak 2.57 MB based on historical data from 2026-04-02 to 2026-04-16

@ 4:00 am to 5:00 am, Thu 2026-04-23

During 4:00 to 5:00 on Thu 2026-04-23, the outgoing traffic observed at endpoint 9.63 MB is higher than predicted peak 2.45 MB based on historical data from 2026-04-02 to 2026-04-16

8 5:00 am to 6:00 am, Thu 2026-04-23

During 5:00 to 6:00 on Thu 2026-04-23, the outgoing traffic observed at endpoint 10.07 MB is higher than predicted peak 2.45 MB based on historical data from 2026-04-02 to 2026-04-16

Rule Summary

‘When (Threshold 1440 minutes

Duration) :

Description : data_sourcetype="FortiGate' and event_type="raffic’

Anomalous download traffic usage detected for endpoint: PC1

Default By Endpoint  traific i anomaly_ detect

PR rcoers Loos

Formatted View ESEVNEION

Alert Time : 4/21/2026, 6:35:24 AM
4/21/2026, 11:35:34 AM
4/21/2026, 10:00:00 AM

4/20/2026, 2:00:00 PM

Update Time
Last Log Time
First Log Time :

Rule Information

Rule Name : Anomalous Download Traffic Usage Detection
Handler Type : basic
Log Type : siem

Acknowledged Time N/A

Automation Stitch :  no
Endpoint
Endpoint )

Endpoint IP:
Endpoint ID: 3629
Dest.ID: 0

MITRE

Alert Details

ErupoTae

Endpoint User ID :
Dest. User ID :

Group By :

Pattern :

Alert D
Alert Type

Severity :

Alert Handler Name :

Device Type
Acknowledged :
Log Count :

Suppressed :

Endpoint Name :

Endpoint User ID :
Dest. User ID :

Weekly Bandwidth Per Hour

ADOM:roct >3- @+ 02 O (Y admin -

1566

Chart View REWIRYET

enduser, endpoint

IF ML_ANOMALY_OUTBOUND_TRAFFIC(")>=5
FILTER data_sourcetype="FortiGate' and event_type="traffic’

ADOM:root >_ @~ L2 © °admlnv

202604211000000002
mi_download_traffic_anomaly
Hgh

Machine Learning Based Anomalous Activity Detection
SIEM

no

7
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e

Default By Endpoint traffic i anomaly_detect

LETRE Triggering Logs

Anomalous download traffic usage detected for endpoint:

ADOM:roct >_ @~ N2 © oadmlnv

; rory S rex
Endpoint IP: 168 Endpoint User ID: 2958
Endpoint ID: 3629 Dest. User ID : 0
B Fabric Dest.ID: 0
B Incidents &Alerts MITRE
Inciden Alert Details
Alerts
[P Table View
Alert Handlers
Weekly Bandwidth Per Hour
Alert Collectors
Indicators
FortiGuard Sen
Automation Les,
Log Parsers
&) FortiAl
B Reports
£ System Settin = " \
 F.000000 Sat.00:00:00 Sun.000000 Mon. 0 Tue. 000000 Th. 00:
Download
Rule Summary
When (Threshold 1440 minutes Group By : enduser, endpoint
Duration)
Description data_sourcetype="FortiGate' and event_type="traffic’ Pattern : IF ML_ANOMALY_INBOUND_TRAFFIC(*)>=5
FILTER data_sourcetype="FortiGate' and event_type="traffic'
Fi:ATINET
FAZVM64-51cbbBde Q-

@ Dashboard

Default By Endpoint  traffic mi_anomaly. detect

s LEERT Triggering Logs
M Log View Endpoint IP :
Endpoint ID : 3629
@ Fabric View Dest.ID : 4
Incidents & Alerts MR
Incidents Alert Details

Alerts
# Collapse All

& 2:00 pm to 3:00 pm, Mon 2026-04-20

Alert Handlers

Alert Collectors
Indicators B32:00 pm to 4:00 pm, Mon 2026-04-20
FortiGuard S
Automation

Log Parsers B94:00 am to 5:00 am, Tue 2026-04-21

& Fortial 85:00 am to 6:00 am, Tue 2026-04-21

B Reports

ystem Settings

Rule Summary

When (Threshold
Duration) :

1440 minutes

Description

FZRTINET

FortiAnalyzer 8.0.0 New Features Guide
Fortinet Inc.

Anomalous download traffic usage detected for endpoint:

oy

data_sourcetype="FortiGate' and event_type="traffic’

ErrapO Tvane

Endpoint User ID -
Dest. User ID :

Group By :

Pattern :

ADOM:root >_ @~

2958
0

During 16:00 to 17:00 on Wed 2026-04-20, the incoming traffic observed at endpoint 154.64 MB is higher than predicted peak 106.93 MB based on historical data from 1969-12-31 to 1969-12-31
During 16:00 to 17:00 on Wed 2026-04-20, the incoming traffic observed at endpoint 206.22 MB is higher than predicted peak 79.15 MB based on historical data from 1969-12-31 to 1969-12-31
& 11:00 pm 2026-04-20 to 12:00 am 2026-04-21

During 16:00 to 17:00 on Wed 2026-04-20, the incoming traffic observed at endpoint 235.94 MB is higher than predicted peak 198.49 MB based on historical data from 1969-12-31 to 1969-12-31
During 16:00 to 17:00 on Wed 2026-04-21, the incoming traffic observed at endpoint 700.97 MB is higher than predicted peak 89.62 MB based on historical data from 1969-12-31 to 1969-12-31

During 16:00 to 17:00 on Wed 2026-04-21, the incoming traffic observed at endpoint 280.17 MB is higher than predicted peak 113.19 MB based on historical data from 1969-12-31 to 1969-12-31

enduser, endpoint

IF ML_ANOMALY_INBOUND_TRAFFIC(")>=5
FILTER data_sourcetype="FortiGate' and event_type="traffic’

Chart View [ELERVET
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Example: Anomalous login

= Q- ADOM: Fortinet >~ @~ L2 © °adm|nv

@ Dashb Anomalous login detected for user: svc-joinad

&0 Device Man: Default By Enduser login location  mi_anomaly_detect

Fortivie PR Triggering Logs | Timeline
[ Logvi SRV Raw JSON

B Fabric View Alert Time : 4/7/2026,5:28:27 PM Alert ID : 202604071000000447
Update Time : 4/8/2026, 8:58:37 AM Alert Type mi_login_anomaly
Incidents & Allerts Last Log Time : 4/8/2026, 8:11:14 AM Severity : High
First Log Time : 4/7/2026, 4:46:44 PM
Incidents
Rule Information
Aerts
A Rule Name : Geolocation Based Anomalous Login Detection Alert Handler Name : Machine Learning Based Anomalous Activity Detection
A G Handler Type basic Device Type SIEM
) Log Type:: siem Acknowledged no
Rkt Acknowledged Time  N/A Log Count : 28
FortiGuard Services
e Automation Stitch:  no Suppressed : no
Log Parsers Endpoint
O Fortial Endpoint User ID: 4582 Endpoint ID : 0
Dest. User ID : 0 Dest. ID: 0
B Reports
MITRE
Alert Details
Table View
: el i
Map  Satellite S Suagk ) 5
. 9 oy [ -
, 4 5
), & & > 2
= o : on
Lo T e . Kezokheton ¥
. Unied statast, | 1 o > Unite

F::RTINET

Q - ADOM:Fortnet >~ @~ L2 & °aﬂmlnv

@ Dashboa Anomalous login detected for user: svc-joinad

3 Device Mana Defaut  By_Enduser login location i anomaly.detect

i PSTEB™ Tiggering Logs | Timeline
¥ Collapse All ChartView [P

@ Baseline login location: Burnaby, Canada
bric View Adeviation was detected on 2026-04-07 16:46:44-07:00

= New location: Paris, France

B incidents & Alerts - New IP Address: 20

Incidents This event may indicate unusual or potentially unauthorized access
Alerts

Alert Handlers

Alert Collectors

Indicators

FortiGuard Services

Automation

© FortiAl
Rule Summary
When (Threshold 1440 minutes Group By : enduser
Duration) :

Ak System settres Pattern IF ML_ANOMALY_LOGIN(")>=1

FILTER

Note

0/1023

FSATINET

FortiAnalyzer 8.0.0 New Features Guide
Fortinet Inc.



Log and Report

Log and Report

This section lists the new features added to FortiAnalyzer for logs and reports:

* Logging on page 33
» Log Forwarding on page 35
¢ Reports on page 37

Logging

This section lists the new features added to FortiAnalyzer for logging:

» FortiData incident support on page 33

FortiData incident support

FortiData is now a supported device for FortiAnalyzer.

The FortiData device (FDTxxxxxx) can be added in FortiAnalyzer Device Manager. The FortiData device will send
SIEM Xlog log files to FortiAnalyzer. These files can be seen in FortiAnalyzer Log View > Logs > Log Browse.

A Warning: Image is not Certified

@ Dashboards >

All Fortinet Logs | Threat Hunting Log Browse E
B8 Device Manager
All Devicesv @ LastNDays v N= 100 Sep 14 To Dec 23 M Display i Delete &, Download =5] Import
B2 Fortiview > Device ID=FDTVMSTM X x @
m Log View v 0O # Device Name + Device ID = VDOM Name + Type + File Name = From + To~ Size CE
Logs E 1 fdt123_new_sn FDTVMSTM root SIEM Xlog.1765222431.log.zst 2025-12-08 11:33... 2025-12-1010:16... 31,480
Log Settings [m} 2 fdt123_new_sn FDTVMSTM root SIEM Xlog.1764714445 log.zst 2025-12-02 14:27... 2025-12-02 14:27... 15393
m Fabric View > O 3 fdt123_new_sn FDTVMSTM root SIEM Xlog.1763503982.log.zst 2025-11-18 14:13...  2025-11-18 14:13.. 15364
ﬂ Incidents & Events N [m} 4 fdt123_new_sn FDTVMSTM root SIEM Xlog.1761679546.log.zst 2025-10-28 12:25... 2025-10-31 16:23... 4,800
[m] 5 fdt123_new_sn FDTVMSTM root SIEM Xlog.1760977608.log.zst 2025-10-2009:26... 2025-10-2110:25... 2,057
© FortiAl
© [m] 6 fdt123_new_sn FDTVMSTM root SIEM Xlog.1760746561.log.zst 2025-10-17 17:16... 2025-10-17 17:31... 1,146
These logs will insert into the FortiAnalyzer SIEM database (siemdb), so the logs can be found in Log View >
Logs > All. The following three types of incident logs are currently supported in FortiAnalyzer 8.0.0:
FortiAnalyzer 8.0.0 New Features Guide 33
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e Issue

(™ FAZVM64-8 = Q-

@ Dashboards > A Warning: Image is not Certified
Fortinet Logs

Threat Hunting | Log Browse

8 Device Manager

QOlastNDays v N= 30 11-23 14:57:12 - 12-23 14:57:12

&2 FortiView >
@ Filter Mode v | Data Source ID=FDTVMSTM X AND | Event Type=issue X

[ Log View ”

# ¥ Date/Time Data Source ID Event Message Even... | Data Parser Name Data Source Tags
Logs
e 1 2025-12-09 13:48:39 FDTVMSTM Publicly shared sensitive ShareP Issue FortiData Log Parser oftp-NA.ext-alert
og Settings

2 2025-12-09 13:48:35 FDTVMSTM Sensitive financial documents ar Issue FortiData Log Parser oftp-NA.ext-alert

B Fabric View >
3 2025-12-09 13:48:35  FDTVMSTM Publicly shared sensitive financi. lssue FortiData Log Parser oftp-NA ext-alert
[ incidents & Events > 4 2025-12-09 13:48:35 FDTVMSTM Legal documents are shared wit| Issue FortiData Log Parser oftp-NA ext-alert
©® FortiAl 5 2025-12-09 13:48:35 FDTVMSTM Publicly shared legal documents Issue FortiData Log Parser oftp-NA.ext-alert
E Reports s 6 2025-12-09 13:48:35  FDTVMSTM Personally Identifiable Informati Issue FortiData Log Parser oftp-NA ext-alert
7 2025-12-09 13:48:35 FDTVMSTM Publicly shared Personally Ident lIssue FortiData Log Parser oftp-NAext-alert

£ System Settings B
8 2025-12-09 13:48:34  FDTVMSTM Protected Health Information (F Issue FortiData Log Parser oftp-NA.ext-alert
9 2025-12-09 13:48:34  FDTVMSTM Publicly shared Protected Healt! lssue FortiData Log Parser oftp-NA ext-alert
10 2025-12-09 13:48:34  FDTVMSTM Credit card numbers are shared  Issue FortiData Log Parser oftp-NA,ext-alert
11 2025-12-09 13:48:34  FDTVMSTM Cardholder Data (CHD) is share Issue FortiData Log Parser oftp-NA.ext-alert
12 2025-12-09 13:48:34  FDTVMSTM Publicly shared credit card numt lssue FortiData Log Parser oftp-NA ext-alert
13 2025-12-09 13:48:34  FDTVMSTM Publicly shared Cardholder Datz Issue FortiData Log Parser oftp-NA,ext-alert
14 2025-12-09 13:48:34  FDTVMSTM Sensitive authentication data (S, Issue FortiData Log Parser oftp-NA.ext-alert
15  2025-12-09 13:48:34  FDTVMSTM Source code is shared with exte lssue FortiData Log Parser oftp-NA ext-alert
16 2025-12-09 13:48:34  FDTVMSTM Publicly shared source code refe Issue FortiData Log Parser oftp-NA.ext-alert

FiATINET Total logs for analysis: 59 days 23 hours 1000 v /Page ~ 0.62 seconds

* Risk Record

@ Dashboards > A Warning: Image is not Certified

Fortinet Logs | Threat Hunting | Log Browse

&8 Device Manager

QOlastNDays v N= 30 11-23 15:00:54 - 12-23 15:00:54

FortiView >
. Data Source ID=FDTVMSTM X AND | Event Type=Risk Record
[ Log View <
# ¥ Date/Time Data Source ID Event Message
ettings 1 2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: SharePoint (Microsoft 365) files containing sensitive data ar|
m Fabric View N 2 2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: Publicly shared sensitive SharePoint (Microsoft 365) files
3 2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: SharePoint (Microsoft 365) files containing sensitive data ar
[} incidents &. Events > 4 202512-0913:4835 EDIVMSTM Risk Record scanned by policy: Sensitive financial documents are shared with external user
© Fortial 5 2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: Publicly shared sensitive financial documents
B Reports s 6 2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: Publicly shared sensitive SharePoint (Microsoft 365) files
7 2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: Publicly shared sensitive SharePoint (Microsoft 365) files
8 System settings 8 202512-09134835 FDIVMSTM Risk Record scanned by policy: Publicly shared legal documents
9 2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: Publicly shared Personally Identifiable Information (PIl)
10  2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: SharePoint (Microsoft 365) files containing sensitive data ar
11 2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: Publicly shared sensitive SharePoint (Microsoft 365) files
12 2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: SharePoint (Microsoft 365) files containing sensitive data ar
13 2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: Sensitive financial documents are shared with external user
14  2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: Publicly shared sensitive financial documents
15 2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: Publicly shared sensitive SharePoint (Microsoft 365) files
16 2025-12-09 13:48:35 FDTVMSTM Risk Record scanned by policy: SharePoint (Microsoft 365) files containing sensitive data ar

FiZRTINET Total logs for analysis: 59 days 23 hours

* Integration Event

FortiAnalyzer 8.0.0 New Features Guide
Fortinet Inc.

1000 v /Page A 1.12 seconds

ADOM: root  >_

e- L1 © °admlnv

T2 Full Screen | [ % Create Custom View] [ @ Refresh] [ £ More |
x Q @
(=
@ Data
Action
Data Parser Name FortiData Log Parser
Data Source ID FDTVMSTM

Data Source Name
Data Source Tags

fdt123_new_sn
oftp-NA ext-alert

Data Source Type FortiData
Data Timestamp 2025-12-09 13:36:15
Date/Time 2025-12-09 1.

Time Stamp 2025-12-09 13:

& Event

Event Category Public Exposure

Publicly shared sensitive SharePoint (Mi

crosoft 365) files refers to documents or
data stored in SharePoint that contain c

onfidential or sensitive information and

have been made accessible to the public
or external parties, intentionally or unint
entionally, through sharing settings.

- Puhlicly shared sensitive SharePoint (Mi

Event Message

Raw log

itime=2025-12-09 13:48:39 epid=1 euid=1 data_parsername=FortiData (
Log Parser data_sourceid=FDTVMSTM

data_sourcename=Ffdt123_new_sn data_sourcetype=FortiData
data_timestamp=1765316175 event_message=Publicly shared sensitive
SharePoint (Microsoft 365) files refers to documents or data stored in
SharePoint that contain confidential or sensitive information and have
been made accessible to the public or external parties, intentionally or

| ]
©3 Full Screen | | % Create Custom View | [ & Refresh | [ § More v |
x Q @
0 x
@ Data
Action

Data Parser Name FortiData Log Parser

Data Source ID FDTVMST™M
Data Source Name fdt123_new_sn
Data Source Tags oftp-NA
Data Source Type FortiData
Data Timestamp 2025-12-09 13:36:17
Date/Time 2025-12-09 1.
Time Stamp 2025-12-09 13:-
B Event

Risk Record scanned by policy: SharePoi
nt (Microsoft 365) files containing sensit
ive data are shared with external users

SharePoint (Microsoft 365) files containi

Event Message

Event Policy ng sensitive data are shared with extern
al users
{\"incident_type\": \"Risk Record\", \"id
\": \"08f2f8bb-5680-4833-afe5-8256e
5c0eR2A" Misaiin id\" \"73R7AANR-29
Raw log

itime=2025-12-09 13:48:35 epid=1 euid=1 data_parsername=FortiData {
Log Parser data_sourceid=FDTVMSTM

data_sourcename=fdt123_new_sn data_sourcetype=FortiData
data_timestamp=1765316177 event_message=Risk Record scanned by
policy: SharePoint (Microsoft 365) files containing sensitive data are
shared with external users event_policy=SharePoint (Microsoft 365) files
containing sensitive data are shared with external users
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@ Dashboards > A Warning: Image is not Certified

Fortinet Logs | Threat Hunting | Log Browse

28 Device Manager

Q@ LlastNDays v N= 30 11-2314:53:31 - 12-23 14:53:31
2 Fortiview >
@ Filter Mode v | (Data Source ID=FDTVMSTM ...%  AND Event Type=Integration Event %
[ Log View v
# | @ Date/Time Data Source ID Event Message Event Type
Logs
Log Setti 1 2025-12-1010:16:11  FDTVMSTM Integration Event scanned by policy: Detect Pll sensitive content Integration Even
0g Settings
ﬂ o 2 2025-12-1010:16:11  FDTVMSTM Integration Event scanned by policy: Detect Pl sensitive content Integration Even
Fabric View >
3 2025-12-09 14:33:04  FDTVMSTM Integration Event scanned by policy: Detect Pll sensitive content Integration Even
B Incidents & Events > 4 2025-12:0914:27:25 FDTVMSTM Integration Event scanned by policy: Detect Pll sensitive content  Integration Even
©® FortiAl 5 2025-12-09 14:27:21  FDTVMSTM Integration Event scanned by policy: Detect Pl sensitive content Integration Even
E Reports R 6 2025-12-09 14:27:15  FDTVMSTM Integration Event scanned by policy: Detect Pll sensitive content Integration Even
7 2025-12-09 14:27:10  FDTVMSTM Integration Event scanned by policy: Detect Pll sensitive content  Integration Even
£ System Settings > 5 - " 5
8 2025-12-09 14:27:05 FDTVMSTM Integration Event scanned by policy: Detect Pl sensitive content Integration Everg
9 2025-12-09 14:27:00  FDTVMSTM Integration Event scanned by policy: Detect Pll sensitive content Integration Even
10  2025-12-09 14:26:56 = FDTVMSTM Integration Event scanned by policy: Detect Pll sensitive content  Integration Even
11 2025-12-09 14:26:55 FDTVMSTM Integration Event scanned by policy: Detect Pl sensitive content Integration Even
12 2025-12-08 11:33:51 FDTVMSTM Integration Event scanned by policy: Detect Pll sensitive content Integration Even

= Total logs for analysis: 59 days 23 hours 1000 v /Page A 0.19 seconds

ADOM:root >. @~ L1 © °admmv

]
£3 Full Sereen | [ & Create Custom View] [ Refresn | [ £ More |
x Q@
O x
@ Data
Action
Data Parser Name FortiData Log Parser
Data Source ID FDTVMSTM
Data Source Name fdt123_new_sn
Data Source Tags oftp-log
Data Source Type FortiData
Data Timestamp 2025-12-10 10:03:52
Date/Time 2025-12-10 1
Time Stamp 2025-12-10 10:16:11
@ Event

Integration Event scanned by policy: Detect Pl s

Event Message ensitive content

Event Policy Detect Pll sensitive content
Event Profile \"predefine\":[\"Personal\", \"Confi
{\incident_type\": \"Integration Event\", \"id\":
\"fea5a2e5-98d6-45ad-8c8b-f6408832238
\"time\": 1765389832.648, \'i \"High\", \"p
olicw detaila\™ (\"storage name\™ \"14FARAIF9
Raw log
itime=2025-12-10 10:16:11 epid=1 euid=1 data_parsername=FortiData Log l

Parser data_sourceid=FDTVMSTM data_sourcename=Ffdt123_new_sn
data_sourcetype=FortiData data_timestamp=1765389832
event_message=Integration Event scanned by policy: Detect Pll sensitive content
event_policy=Detect Pll sensitive content event_profile.predefine_0=Personal
event_profile.predefine_1=Confidential event_profile={\"custom\™{},
\"predefine\":[\"Personal\’, \"Confidential\']} event_severity=high

The predefined Ingested External Alerts event handler, enabled by default, will trigger alerts from FortiData
Issue logs. These alerts can be found in Incidents & Events > Event Monitor.

@ Dashboards > A Warning: Image is not Certified

ApoMiroot - @~ Ot i (@) edmn-

Explorer @ARITHICE By Endpoint | By Threat | System Events | Toggle Views D
B8 Device Manager
2, Create Custom View | All Devicesv @ LastNDays v N= 30 2025-11-23 15:06:18 - 2025-12-23 15:06:18 Show Acknowledged Show External | ,* Expand All > Refresh v &
& Fortiview >
devname="fdt123_new_sn" x Q
M Log View >
O | Events EventSt.. + EventTypes | Co.. > Severity= | FirstOccurr... = | LastUpdate =  Handler + Tags = H
@ Fabric View > O @ Publiclyshared sensitive SharePoint (Microsoft 365) files (3) | Unhandled  Issue 3 ®Critical  21daysago  14daysago  Ingested External Alerts Extalert | NIST 80051
| I Incidents & Events . O Publicly shared sensitive SharePoint (Microsoft 365) files Unhandled  Issue 1 ®Critical | 2025-12-09 13:4 2025-12-09 13:4 Ingested External Alerts NIST 800-5:
Incidents [m] Publicly shared sensitive SharePoint (Microsoft 365) files Unhandled | Issue 1 @ Critical 2025-12-08 13:% 2025-12-08 13:5 Ingested External Alerts NIST 800-5;,
Event Monitor [m] Publicly shared sensitive SharePoint (Microsoft 365) files Unhandled  Issue 1 @ Critical | 2025-12-02 14:2 2025-12-02 14:2 Ingested External Alerts NIST 800-5:
Event Handlers O @ Personally Identifiable Information (Pll) is shared with externalu Unhandled  Issue 3 High 21 days ago 14 days ago Ingested External Alerts [Ext-alert | GDPR ][ fdt
(Bt Gl i [m] Personally Identifiable Information (PlI) is shared with external use Unhandled  Issue 1 High 2025-12-09 13:4 2025-12-09 13:4 Ingested External Alerts [t
Indicators
. 0 Personally Identifiable Information (PIl) is shared with external use Unhandled  Issue 1 High 2025-12-08 13:5 2025-12-08 13:5 Ingested External Alerts Tt
FortiGuard Services
Automation a Personally Identifiable Information (Pll) is shared with external use Unhandled  Issue 1 High 2025-12-02 14:2 2025-12-02 14:2 Ingested External Alerts [t
Log Parsers [u} ‘ [ @] Legal documents are shared with external users (3) Unhandled  Issue 3 ®Ciitical  21daysago  14daysago Ingested External Alerts Ext-alert | GLBA |[SO
© Fortial [m] Legal documents are shared with external users Unhandled  Issue 1 @ Critical | 2025-12-09 13:4 2025-12-09 13:4 Ingested External Alerts
oL [m] Legal documents are shared with external users Unhandled  lssue 1 @®Critical  2025-12-08 13:5 2025-12-08 13:5 Ingested External Alerts
eports B
O Legal documents are shared with external users Unhandled | Issue 1 ®Critical | 2025-12:02 14:7 2025-12-02 14:2 Ingested External Alerts
& system Settings 4 [m] Publicly shared sensitive financial documents (3) Unhandled  Issue 3 @ Critical 21 days ago 14 days ago Ingested External Alerts

You can create custom event handlers in FortiAnalyzer to trigger alerts using the other log types from FortiData

as well.

Log Forwarding

This section lists the new features added to FortiAnalyzer for log forwarding:

» FortiAnalyzer Fluentd supports the Azure Monitor Log Ingestion APl on page 36

FortiAnalyzer 8.0.0 New Features Guide
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FortiAnalyzer Fluentd supports the Azure Monitor Log
Ingestion API

Ly
.

g This information is also available in the FortiAnalyzer 8.0 Administration Guide:
¢ Output profiles
¢ Output profile example

FortiAnalyzer Fluentd now supports the Azure Logs Ingestion APl in Output Profiles.

To configure the log ingestion in the Azure portal:

Login to your Azure portal: https://portal.azure.com.
Create an application through App registration.
Create a Log Analytics Workspace.
Create a Data Collection Endpoint (DCE).
Create a new custom table (Direct Ingest).
« When creating the table, if no data collection rule exists, select Create a new data collection rule to
create one.
» For the required sample.json, prepare the content as {"logtime": "2026-01-
16T20:30:00Z", "message": "hello logs ingestion"}.
» For the transformation, use source\n| extend TimeGenerated = todatetime(logtime)\n| project-
away logtime\n, which indicates:

a bk ON =

e extend TimeGenerated = todatetime(logtime): add a new column named TimeGenerated into
the table with the value as todatetime(logtime). This is mandatory since the Azure Logs
Ingestion API requires the column TimeGenerated.

e project-away logtime: discard the column logtime.

e When creating a custom table, you must use the _CL suffix. For example, instead of naming the table
"apptest”, you must name it "apptest_CL".

» Complete the App Registration in which Tenant ID and Client ID are available. You must Create Secret
to get Client Secret(value) for this application.

¢ Addrole assignment(Monitoring Metrics Publisher) to link the application with the DCR.

To configure the FortiAnalyzer Fluentd in an Output Profile:

1. Go to System Settings > Advanced > Log Forwarding > Output Profile.
2. Click Create New.

The Create Output Profile pane displays.
3. Configure the following options:

Option Description

Name Enter a name for the output profile.

Type Select Azure Logs Ingestion.

FortiAnalyzer 8.0.0 New Features Guide
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Option Description

Configuration Click Use Default to use the default Fluentd configuration. The default
configuration indicates that:

# The following six parameters are required.
tenant_id #<TENANT_ID>

client_id #<CLIENT_ID>

client_secret #<CLIENT_SECRET>

dce_url #<DCE_URL>

dcr_id #<DCR_ID>

table_name #<TABLE_NAME>

Field | Value | Action Configure the required parameters according to your Azure portal.
For example:

TENANT_ID Enter the tenant ID for the Azure portal.
CLIENT_ID Enter the client ID for the Azure portal.

CLIENT_SECRET Enter the client secret for the Azure

portal.
DCE_URL Enter the Data Collection Endpoint URL.
DCR_ID Enter the Data Collection Rule ID.

Enter the custom table name from the

TABLE_NAME
Azure portal.

4. Click Validate and Save.

5. You can now use this Output Profile in Log Forwarding from the FortiAnalyzer. For more information about
configuring Log Forwarding using an output profile, see the FortiAnalyzer Administration Guide.

Reports

This section lists the new features added to FortiAnalyzer for reports:

¢ Anomaly login report on page 38
» FortiDeceptorincident report on page 42
e Shadow-Al report on page 48

FortiAnalyzer 8.0.0 New Features Guide
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Anomaly login report

Ly

g This information is also available in the FortiAnalyzer 8.0 Administration Guide:
e ZTNA login alert handlers

The new Anomaly Login Report provides a comprehensive overview of security events involving remote users
and devices accessing office resources through Zero Trust Network Access (ZTNA). The report examines user
behavior, including concurrent access with multiple devices, unusual login locations or times, access to atypical
resources, abnormal data transfers, and other relevant factors. Categorizing these evens as security breaches
or suspicious activities, the report offers valuable insights into potential threats.

This report requires FortiAuthenticator event logs in FortiAnalyzer to trigger the predefined ZTNA Login
Anomaly Detection alert handler. For more information about this alert handler, see the FortiAnalyzer
Administration Guide.

The Anomaly Login Report is a global report, and it can be found in the Fabric Reports folder in Reports > Report

Definitions > All Reports.
(™ FAzVMS4 Q -~ ADOM:root >- @~ L1 © oadmln -

@ Da PRGN Templates | Chart Library | Macro Library | Datasets
B [ ice Manager © Run Repor | €3 Report v | [ & Folder v | [ # More v | O show scheduled only Searc a »
otV @ |Titles Language | Cache Status = | Time Period + Devices+ | Schedule | Origin | Config Recommendation* | Output Profile = | Report Owner :E
§ FortiView
(] & Application Reports
[ Log View "
[m] & Asset and User Reports
Fabric View (] B Compliance Reports
B Incidents & Alerts O © ErabricReports
) 5 Anomaly Login Report English This Week Al Devices ®Builtin B
O FortiAl
(m] B Endpoint Security Vulnerability Report English (®Built-in | B
B Reports [m] B3 360 Protection Report English Previous 7 Days All Devices ®Built-in | B
Generated Reports (m] B Bandwidth and Applications Report (SIEM) | English Previous 7 Days All_FortiGate @®Builtin | B
Report Definiti N " ) )
CAIELE ) O & Fortinet Email Risk Assessment English Previous 7 Days All Devices ®Bult-in | B
Advanced Settings N
[m] B FortiPortal User Summary Report English Previous 7 Days All Devices ®Built-in | B
¥ System Settings N N . . i i ilt-i
(m] B Security Events and Incidents Summary English Previous 7 Days All_FortiGate (®Built-in | B
a B situation Awareness Report English Previous 7 Days All Devices ®Built-in | B
[m] B What is New Report English Previous 7 Days All Devices (®Built-in | B
[m] B& FortiADC Reports
[m] & FortiCache Reports
[m] FortiClient Reports
Fi:RTINET Total Selected: 1 0% 338
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FAZVMé64

@ Dashboards

All Reports

ACWEICE Chart Library | Macro Library

Datasets

The report template can be found in Reports > Report Definitions > Templates.

Manager

FortiView
M Log View
@ Fabric View
B Incidents & Alerts
© FortiAl
(=

Generated Rep

Report Definitions

Advanced Settings

£ System Settings

FERTINET

[+ Create New | [ @ View|

More v

=

0 0O0DOo

O0oo0oOO0OO0DoOoOO0OO0OO0OO

A

Total Selected: 1

Title 4
H Template - 360 Protection Report

B Template - 360 Security Report

B Template - 360-Degree Security Review

H Template - Admin and System Events Report

= Template - Anomaly Login Report

B Template - Application Risk and Control

H Template - Asset and Identity Report

M Template - Bandwidth and Applications Report

B Template - Bandwidth and Applications Report (SIEM)
H Template - C-Suite SD-WAN Insights Report

E Template - CIS Controls Security Rating Report

B Template - Client Reputation

H Template - Cyber Threat Assessment

M Template - Cyber-Bullying Indicators Report

B Template - Daily Summary Report

H Template - Data Loss Prevention Detailed Renort

«

Description %

Present a brief summary of hardware/software inventory of the FortiGate devices over a 30 day period.

Present a brief summary report about traffic, threat, app, user, incident, compromised host and so on.

Category +

Security review of Application Visibility and Control, Threat Detection, Data Exfiltration Detection, Endpoint Detection, P, Security

Admin login and failed login attempts and system severity event counts.

Present a brief summary of Anomaly Login activity, specifically highlighting events captured by related event handlers witl Security

Present a brief summary report on assets and their users, vulnerabilities, software installed as well as running processes.

Traffic, Bandwidth, Sessions, Destinations summaries - by users and applications

Traffic,

1, Sessions, Destination:

ummari

Present an SD-WAN insights report which focuses on high-level key performance indicators.

Present a brief summary report about CIS Controls security rating report.

Client and user network behaviour, incidents by user, devices, threat summary.

Cyber Threat review of Application Visibility and Control, Threat Detection, Prevention and Recommended Actions.

Cyber-Bullying Indicators Report.

Present a brief summary report about traffic, threat, app, user, incident, compromised host and so on.

Violation Summary and Activitv Details of Email. Web. and FTP.

Preview + Or'\g'\rI

System HTMLPDF | (% Buil

Security ~ HTMLPDF  (®Buil

HTMLPDF | (% Buil

System HTMLPDF | (% Buil

HTMLPDF  (® Buil

Application risk, categories, bandwidth by app, web categories, vulnerability exploits, virus, botnet, adware malicious attac Application = HTMLPDF (% Buil
Assets HTMLPDF | (% Buil

Application  HTMLPDF | (® Buil

- by users and applications Application  HTMLPDF | (® Buil
System HTMLPDF | (% Buil

Security ~ HTMLPDF  (®Buil

User HTMLPDF | (% Buil

Security  HTMLPDF  (®Buil

Application  HTMLPDF | (® Buil

Security ~ HTMLPDF  (®Buil

Security ___HTMLEDF (b Buil

0% ¢

The Anomaly Login charts used for the report can be found in Reports > Report Definitions > Chart Library.

FAZVMé4

@ Dashboards

All Reports

Templates JMOLELARIELMN Macro Library

Datasets

ADOM:root > @~ L © °adminv

B0 Device Manager

FortiView

© Fortial
B Reports

Generated Rep
Report Definitions

Advanced Settings

System Setting

FZERTINET

+ Create New

0000 O0Om

(< JRN < RN < N« |

0O o0ooo0oaOo

[m]

Name &
[l Active Traffic Users

[ Admin Login Summary by Date

[# Admin Login Summary with failed

Bl Adware Timeline

C All Applications Discovered on the Network

C Anomaly Login Incident Count by Severity

C Anomaly Login Incident Count by Status

[ Anomaly Login Incident End User

[ Anomaly Login Incident End User List

= Anomaly Login Incident User Attachment

[ Antivirus Inspections

C App Categories

@ App Categories (Pie)

Bl App Risk Control Files Analyzed by FortiCloud Sandbox
[ Application Bandwidth Usage

£ Application Behavioral Characteristics

Total Selected: 5
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View Options v

Description +

List of active traffic users
Administrator login summary by date
Administrator login summary by date
Adware timeline

All Applications Discovered on the N
Anomaly Login Incident Count by Se
Anomaly Login Incident Count by Stz
Anomaly Login Incident End User
Anomaly Login Incident End User Lis
Anomaly Login Incident User Attachr
Antivirus Inspections

Application categories by bandwidth
Application categories by bandwidth
App Risk Control Files analyzed by Ft
Application bandwidth usage details

Application Behavioral Characteristic

Device Type &
FortiGate

FortiGate
FortiGate
FortiGate
FortiGate
FortiAuthenticator
FortiAuthenticator
FortiAuthenticator
FortiAuthenticator
FortiAuthenticator
FortiGate
FortiGate
FortiGate
FortiGate
FortiGate

FortiGate

Category =

Traffic

Event

Event

Antivirus

Traffic

Event

Event

Event

Event

Event

Antivirus

Traffic

Traffic

Antivirus

Traffic

Traffic

Origin =
Built-in
(® Built-in
2 Custom
Built-in
( Built-in
O Built-in
Built-in
Built-in
Built-in
(Built-in
Built-in
™ Built-in
(Built-in
Built-in
Built-in

(™ Built-in

3% 1,875
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The Anomaly Login macros used for the report can be found in Reports > Report Definitions > Macro Library.

FAZVM64 = Q-

@ Dashboards All Reports | Templates | Chart Library [NEHGIRERT

33 Device Manager

FortiView &
a
a
Fabric View [m]
B Incidents & Alerts ]
:
© Fortial
B Reports
Generated Reports
Report Definitions
Advanced Settings
£F System Settings
[m}
[m}
a
a
a
a

+ [Create New

Name &

[# 00-macro

[® 360-Security Total Malware Detected

[® Affected Endpoint Count

[® Analyzed Security Event Count

[# Anomaly Login Enduser Count

% Anomaly Login Incident Count with High Risk

[# Anomaly Login Incident Count with Medium Risk
[# Anomaly Login Incident Endpoint Icon

[# Anomaly Login Incident Enduser Icon

[# Anomaly Login Incident Severity lcon

[® App Count of Self-Harm Risky Terms

[® Application Category with Highest Bandwidth

[# Application Category with Highest Session Count
[® Application Risk Malware Total Count

[® Application Risk Threats Total Count

[® Application Risk Total Bandwidth

F:ERTINET Total Selected: 6

ADOM:root - @~ L1 @ () admin-
Datasets D
View Options v @ &
Description & Device Type * Category + Origin + E
test FortiGate Traffic 2 Custom |
360-Security Total Malware Detected FortiGate Virus (® Built-in
Affected Endpoint Count FortiGate (™ Built-in
Analyzed Security Event Count FortiGate (™ Built-in
Anomaly Login Enduser Count FortiAuthenticator Event (® Built-in
Anomaly Login Incident Count with High Risk FortiAuthenticator Event (™ Built-in
Anomaly Login Incident Count with Medium Risk FortiAuthenticator Event (® Built-in
Anomaly Login Incident Endpoint Icon FortiAuthenticator Event (® Built-in
Anomaly Login Incident Enduser Icon FortiAuthenticator Event (® Built-in
Anomaly Login Incident Severity lcon FortiAuthenticator Event (® Built-in
App Count of Self-Harm Risky Terms FortiGate Application Control (®Buiilt-in
Application Category with Highest Bandwidth FortiGate Trafic (™ Built-in
Application category with the highest session count FortiGate Traffic (®Built-in
Application Risk Malware Total Count FortiGate Traffic (® Built-in
Application Risk Threats Total Count FortiGate Application Control (®Built-in
Application Risk Total Bandwidth FortiGate Traffic (™ Built-in

0% 370

The Anomaly Login datasets (incidennt-Anomaly-Login) used for the report can be found in Reports > Report

Definitions > Datasets.

FAZVM64 Q-

@ Dashboar All Reports | Templates | Chart Library | Macro Library RIS

ADOM:root >— @~ L1 © oadmmv

View Options v

88 Device Manager

Foriv ® |Name# Device Type %
ortiView
] Log View £ High-Risk-Application-By-Sessions FortiGate
incident-Anomaly-Login-Count-by-Severity FortiAuthenticator
incident-Anomaly-Login-Count-by-Status FortiAuthenticator
B incidents & Alerts incident-Anomaly-Login-End-User FortiAuthenticator
© Fortil incident ly-Login-End-User- FortiAuthenticator
incident-Anomaly-Login-End-User-Count FortiAuthenticator
B Reports
incident-Anomaly-Login-End-User-List FortiAuthenticator
Generated Reports
ebor Datnit incident-Anomaly-Login-Endpoint-and-Enduser-Count FortiAuthenticator
eport Definitions
P T— incident-Anomaly-Login-High-Risk-Count FortiAuthenticator
£ 5ystem Settings = incident-Anomaly-Login-Medium-Risk-Count FortiAuthenticator
ystem 2
incident-Incident-Count-by-Status FortiGate
= incident-Incident-Count-Timeline FortiGate
Interested-Applications-by-Risk-Level FortiGate
intf-Device-Revd-Sent-Summary FortiGate
S intf-Device-Sent-Summary FortiGate
m intf.Navica-Summan: FortiGate

FZERTINET Total Selected: 9

Below is a sample of some pages from the report in PDF format.
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Log Type &

Traffic
Event
Event
Event
Event
Event
Event
Event
Event
Event
Application Control
Application Control
Traffic
Event
Event

Fuent

Origin %

( Built-in

@ Buil
(® Built-in

@ Buil
(® Built-in
@ Built-in
® Buil
@ Built-in

(® Built-in

@ Built-in
(® Built-in
@ Built-in
( Built-in

B Ruilt-in

36% 2,02¢
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Anomaly Login Report F::RTINET

Data Range: 2026-02-15 00:00:00 2026-02-20 11:38:14PST

EXECUTIVE SUMMARY

The report provides a comprehensive overview of security events involving remote users and devices accessing office resources through Zero Trust Network Access (ZTNA). It
examines user behavior, including concurrent access with multiple devices, unusual login locations or times, access to atypical resources, abnormal data transfers, and other
relevant factors. Categorizing these events as security breaches or suspicious activities, the report offers valuable insights into potential threats.

A 27 Critical/High Risk Incidents 75 Medium Risk Incidents @ 86 Users L0 38 Devices

INCIDENT SEVERITY INCIDENT STATUS

@ 75 Medium Risk

102 18 Critical Risk 102 ® 102 New

Incidents # 9 High Risk Incidents

page 1 of 31
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Anomaly Login Report =:RTINET

Data Range: 2026-02-15 00:00:00 2026-02-20 11:38:14PST

2

g High Risk
ZTNA Brute Force Login

. Authentication Failed from Multiple Geo Locations Authentication Failed from Multiple Geo Locations
Authentication failed from multiple geo locations for user: Authentication failed from multiple geo locations for user:
41 Canada, = Germany, @ New Zealand @ New Zealand, [+« Canada, = Germany

. Authentication Failed from Multiple Geo Locations Authentication Failed from Multiple Geo Locations
Authentication failed from multiple geo locations for user: Authentication failed from multiple geo locations for user:
i+41 Canada, P Germany, @ New Zealand @ New Zealand, /1 Germany, [+« Canada

L] Authentication Failed from Multiple Geo Locations Authentication Failed from Multiple Geo Locations
Authentication failed from multiple geo locations for user: Authentication failed from multiple geo locations for user:
= Germany, [+l Canada, @ New Zealand = Germany, [+l Canada

] Authentication Failed from Multiple Geo Locations Authentication Failed from Multiple Geo Locations
Authentication failed from multiple geo locations for user: Authentication failed from multiple geo locations for user:
i+l Canada, @@ New Zealand B New Zealand, ™ Germany, == United States

. Authentication Failed from Multiple Geo Locations Authentication Failed from Multiple Geo Locations

Authentication failed from multiple geo locations for user:
B MNew Zealand, ™ Germany, [+] Canada

High Risk
Anomaly Login Detection

Successful Authentication from Multiple Geo Locations

Suspicious successful authentication from multiple geo locations for user:

Authentication failed from multiple geo locations for user:
@ New Zealand, /M Germany, & United States

Successful Authentication from Multiple Geo Locations
Suspicious successful authentication from multiple geo locations for user:

B New Zealand: Auckland, o India: Bangalore =5 United States: Miami, [+] Canada: Vancouver, @ New Zealand: Auckland

page 2 of 31

FortiDeceptor incident report

s

? This information is also available in the FortiAnalyzer 8.0 Administration Guide:
* Using the template - FortiDeceptor incident report

The new FortiDeceptor Incident Report lists Critical and High risk incidents triggered by an alert handler. The
report includes the attacker IP and the victim IP, user, port, incident ID, and more so for SOC analysts to use the
report effectively for incident triage and response.

This report requires FortiDeceptor logs in FortiAnalyzer to trigger the predefined Default-FDC-Honey-Pot-
Detection alert handler. This alert handler is disabled by default, and it must be enabled in Incidents & Alerts >

FortiAnalyzer 8.0.0 New Features Guide
Fortinet Inc.
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Alert Handlers.

FAZVMé4 Q ~ ADOM: root

Notification Profiles

@ Dashboards LU ENES  Data Selectors

= Device Manager ‘ <+ Create New‘ [ Edit‘ ‘ " Clone ‘ : More v fortideceptor @ J*
FortiView St..~ Name= Rules = Origin Data Selector = H
[ = Default-FDC-Honey-Pot-Detection - e
m Log View @ e B A P Rule-1 Attack detected by FDC: (Default,FortiDeceptor (® Built-in
[ Edit
@ Fabric View 1 Delote
Incidents & Alerts % Clone
Incidents © Enable
Alerts @ Disable
Alert Handlers 31 Import
Alert Collectors B Export
Indicators
C Factory Reset
FortiGuard Services

Automation

Log Parsers

1O FortiAl
FZ:RTINET Total Selected: 1 1/296

Incidents triggered by the alert handler can be found in Incidents & Alerts > Incidents. The Name of the related
incidents begin with FDC-Honey-Pot-Detection.
(™ FAzVMGA ADOM:root >_ @~ L1 © o admin ~

@ Dashboards IWLENCE MITRE ATT&CK® v | MITRE ATT&CK® ICS v

ﬂ Device Manager ‘ Severity Status Category Outbreak ...
M Medi.. 8 W New 125 W Malic... 8 M Critical 1
FortiView M Critical 27 [ Analysis © M Unau... 27 W High o
EHigh  © B Respon... 0 125 B Denial ... ? W Medium 0
2 W Low o @ Review 0 @ Improp... 0 H Low 0
Log View
m ° W Closed:... 0 B Scans /... @

@ Fabric View

QA v Show Charts Search @ *

Incidents W Names$ Severity + | Indicator Affected Endpoint Description = n

Incidents & Alerts + Create New ‘ ‘ T Delete ‘

Alerts

O Malicious-File-Detection-By-Endpoint: Critical
Alert Handlers
FDC-Honey-Pot-Detection: Attacker: detected ... Medium
Alert Collectors ]
refeiens FDC-Honey-Pot-Detection: Attacker: detected b... Medium
FortiGuard Services FDC-Honey-Pot-Detection: Attacker: detected b... Medium
Automation FDC-Honey-Pot-Detection: Attacker: detected b... Medium
Log Parsers ) )
FDC-Honey-Pot-Detection: Attacker: detected by ... Medium
© FortiAl FDC-Honey-Pot-Detection: Attacker: detected by F... Medium

FoiRTINET EOC i ok Do a db | naeane
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The report can be found in the FortiDeceptor Reports folder in Reports > Report Definitions > All Reports. It is an

ADOM-level report.

(™ FAzvMés

@ Dashboards

E Device Manager
FortiView

m Log View

@ Fabric View
Incidents & Alerts
I©® FortiAl

E Reports

Generated Reports
Report Definitions

Advanced Settings

& System Settings
F::=RTINET

(™ FAzvMé4

@ Dashboards
E Device Manager
FortiView
ﬂ] Log View

Fabric View
Incidents & Alerts
I©® FortiAl

E Reports

Generated Reports
Report Definitions

Advanced Settings

& System Settings

All Reports

Q-

Templates | Chart Library

Macro Library

ADOM: root-new1 >

9 L O °adminv

Datasets

|° Run Report ‘ ‘Q Report v ‘ ‘ & Folder v ‘

§ More v | (J Show Scheduled Only

Search...

Total Selected: 1

Title

e
B FortiClient Reports
B FortiDDoS Reports

@ B FortiDeceptor Reports

0000 (w

B FortiDeceptor Default Report
B FortiDeceptor Incident Report
B& FortiEDR Reports
IS FortiFirewall Reports

IS FortiGate Reports

0Oo0ocao

B& FortiMail Reports

FortiNAC Renorts

Language & | Cache Status ¢  Time Period < Devices ¢ | Schedule ¢ | Origin < COE

Chart Library

The report template can be found in Reports > Report Definitions > Templates.

Macro Library

English Previous 7 Days All Devices (™ Built-in B
English Previous 7 Days All_FortiDe: (™ Built-in B
37% 333

ADOM: root-new1 >

Datasets

=] Template - FortiClient Vulnerability Scan Repc
=] Template - FortiDDos Default Report

=] Template - FortiDeceptor Default Report
ETempIate - FortiDeceptor Incident Report

=] Template - FortiEDR Report

=] Template - FortiFirewall Bandwidth and Appli
=] Template - FortiGate Performance Statistics F

=] Template - FortiMail Analysis Report

0o000o0o

=] Template - FortiMail Default Report

1 @ Temolat

ortiMail Summarv Renort

Total Selected: 1
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en

en

en

en

€l

=1

en

en

en

en

Search..

Description =

The vulnerabilities detected through Forticlient scans across the network

Attacks and attackers by time period. Top 20 attacks, attack types, destinations and destinations by t
Present a quick summary of incidents and alerts generated by FortiDeceptor

Present a quick summary of incidents generated by FortiDeceptor, specifically highlighting events ca|
Present a brief summary report about FortiEDR analysis.

Traffic, Bandwidth, Sessions, Destinations summaries - by users and applications

FortiGate Performance Statistics Report.

Statistics for Avg and Total mail size, number of mails and connections, delays, ip policies, recipient p
Top 10 client IP, senders, virus senders, local users, recipients and virus recipients

FortiMail summaryv per domain.

36% 94
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The FortiDeceptor charts used for the report can be found in Reports > Report Definitions > Chart Library.

ADOM:rootnewl >- @~ L1 & ° admin v
(o, ELANLIELYAN Macro Library

(™ FazvM64

@ Dashboards All Reports Datasets

32 Device Manager + Create New View Options v fortideceptor @ *
ER W  Name+ Description = Device Type =+ | Category = Oriu
O ] FortiDeceptor-FDC Incident Attachment FDC Incident Attachment FortiDeceptor ~ Event (™ Bui
m Log View
(& FortiDeceptor-FortiDeceptor Incident Count by Status FortiDeceptor Incident Count by Status FortiDeceptor  Event (™ Bui
@ Fabric View (3 FortiDeceptor-FortiDeceptor Incident Count by User Status FortiDeceptor Incident Count by User Status FortiDeceptor  Event (™ Bui
@ Incidents & Alerts BE FortiDeceptor-FortiDeceptor Incident High Risk Attacker and Victims Lis FortiDeceptor Incident High Risk Attacker and Victims = FortiDeceptor  Event (™ Bui
o B FortiDeceptor-FortiDeceptor Incident Top Attacker IP FortiDeceptor Incident Top Attacker IP FortiDeceptor  Event (™ Bui
FortiAl
E FortiDeceptor-FortiDeceptor Incident Top Victim IP FortiDeceptor Incident Top Victim IP FortiDeceptor  Event (™ Bui
E SEETIE BE FortiDeceptor-FortiDeceptor Medium Risk Incident List FortiDeceptor Medium Risk Incident List FortiDeceptor  Event (™ Bui
Generated Reports (] &= FortiDeceptor-FortiDeceptor-Top Attack Tools Based On IPS Alerts Top 10 Attack Tools Based On IPS Alerts FortiDeceptor  Event (™ Bui
Report Definitions = . . N .
O = FortiDeceptor-FortiDeceptor-Top Attacker IPs Based On IPS Alerts Top 10 Attacker IPs Based on IPS Alerts FortiDeceptor ~ Event (™ Bui
Advanced Settings
O [&] FortiDeceptor-FortiDeceptor-Top Attacker IPs By Incidents Top 10 Attackers IPs by Incidents FortiDeceptor  Event (™ Bui
¢ System Settings -
(] = FortiDeceptor-FortiDeceptor-Top Failed Login By Username Top 10 Failed Login by Username FortiDeceptor  Event (™ Bui
O C FortiDeceptor-FortiDeceptor-Top Malicious Files By Incidents Top 10 Malicious Files by Incidents FortiDeceptor  Event (™ Bui
Total Selected: 6 0% 15/1,843
(™ Fazvmea ADOM:root-newl >_ @~ A1 © o admin ~

O

@ Dashboards i Datasets

% Device Manager <+ Create New View Options v FortiDeceptor-FortiDeceptor ®&  .*
0O  Name?* Description = Device Type * Category = n
O i-4 FortiDeceptor-FortiDeceptor Incident Count with High Risk FortiDeceptor Incident Count with High Risk FortiDeceptor Event
m Log View
a i-4 FortiDeceptor-FortiDeceptor Incident Count with Medium Risk FortiDeceptor Incident Count with Medium Risk FortiDeceptor Event
@ Fabric View O 3 FortiDeceptor-FortiDeceptor Incident Total Count FortiDeceptor Incident Total Count FortiDeceptor Event
@ Incidents & Alerts O [ FortiDeceptor-FortiDeceptor Incident Total Count with Closed Status FortiDeceptor Incident Total Count with Closed Status =~ FortiDeceptor Event
© FortiAl
E Reports
Generated Reports
Report Definitions
Advanced Settings
# System Settings
4/369
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Log and Report

The FortiDeceptor datasets (fdc-Incident) used for the report can be found in Reports > Report Definitions >
Datasets.
(™ FazvMe6a ADOM:root-newl >_ @~ Q1 © ° admin v

@ Dashboards Chart Library | Macro Library JREEERS O
ﬂ Device Manager View Options v fdc-in @ J*
FortiView s Device Type = Log Type = Origin = E

FortiDeceptor Event (™ Built-in
m Log View
FortiDeceptor Event (™ Built-in
@ Fabric View FortiDeceptor Event (™ Built-in
@ Incidents & Alerts fdc-Incident-Count-by-Status FortiDeceptor Event (™ Built-in
£ fdc-Incident-High- Risk-Attacker-And-Victims-List FortiDeceptor Event (™ Built-in
© FortiAl
S fdc-Incident-High-Risk-Count FortiDeceptor Event (™ Built-in
B Reports £= fdc-Incident-List-Per-Attacker FortiDeceptor Event (™ Built-in
Generated Reports £= fdc-Incident-Medium-Risk-Count FortiDeceptor Event ( Built-in
Report Definitions
fde-Incident-Top-Attacker-IP FortiDeceptor Event (™ Built-in
Advanced Settings
£E fde-Incident-Top-Victim-IP FortiDeceptor Event (™ Built-in
# System Settings _
SE fde-Incident-Total-Count FortiDeceptor Event (™ Built-in
£E fdc-Incident-Total-Count-with-Closed-Status FortiDeceptor Event (™ Built-in

FERTINET 00 REGE S aCR Y 0% 12/2,022

Below is a sample of some pages from the report in PDF format.

FortiDeceptor Incident Report S:RTINET

-
Data Range: 2026-02-15 00:00:00 2026-02-20 16:08:39PST

EXECUTIVE SUMMARY

FortiDeceptor uses deception technology to strengthen breach protection by detecting and stopping attacks from internal and external sources before they
cause harm. This report details incidents, including attacker and victim information, incident specifics, and investigation results.

A 0 Critical /High Risk Incidents 7 Medium Risk Incidents 7 Total # of Incidents @ 0 Closed
TOP 5 ATTACKERS TOP 5 VICTIM IP INCIDENT STATUS
IP # of Events IP # of Events
19 19
14 4
4 4 ® 7 New
4
3 3
page 1of 8
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FortiDeceptor Incident Report F::RTINET

-
CTH
Data Range: 2026-02-15 00:00:00 2026-02-20 16:08:39PST

INCIDENTS
H Attacker
User
1 ® 1New
lP Incidents
Port NA

Victim [P

L Assign To
Victim Port NA Description
Detected By -FDC
L] Attack detected by FDC # Port_Scan
attackerip: 137
L] Port_Scan ® Port_Scan

137 137

page 2 of 8
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FortiDeceptor Incident Report F::RTINET

Data Range: 2026-02-15 00:00:00 2026-02-20 16:08:39P5T

H Attacker

NA
FDC

. Attack detected by FDC » Port_Scan
attackerip: 3702

[} Port_Scan ® Port_Scan
3702 3702

L] Port_Scan ® Port_Scan
3702 3702

. Port_Scan ® Port_Scan
3702 3702

. Port_Scan ® Port_Scan
3702 3702

[} Port_Scan ® Port_Scan
3702 3702

page 3of 8

Shadow-Al report

The Shadow-Al Report is a new report template for FortiOS GenAl detections coming from Application Control
(app-ctrl), DLP (dIp), Web Filter (webfilter), and DNS (dns) logs. This report highlights organizational Al
adoption, with a focus on sanctioned versus unsanctioned usage, top applications, and user activity.

FortiAnalyzer 8.0.0 New Features Guide 48
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Log and Report

The Shadow-Al Report can be found in Reports > Report Definitions > All Reports.

(™ FAzvM_025

Q-

l;ll 6 °adminv

@ Dashboards > PAUGGHGLCE Templates | Chart Library | Macro Library | Datasets I]
=0 Device Manager ‘ © Run Report ‘ ‘C& Report v ‘ ‘ & Folder v ‘ 2 More v | [J Show Scheduled Only @
FortiView N m Title ® Language < @ Cache Status = | Time Period < Devices + Schedule< | Origin = COE
E
& B Fabric Reports
m Log View > o P
(] B Anomaly Login Report English (™ Built-in B
Fabric View > N R L .
d B Endpoint Security Vulnerability Report English (™ Built-in B
Incidents & Alerts > O BS 360 Protection Report English Previous 7 Days All Devices (™ Built-in B
u FortiAl > O BS Bandwidth and Applications Report (SIEM) English Previous 7 Days All_FortiGal (™ Built-in B
(] B Fortinet Email Risk Assessment English Previous 7 Days All Devices (™ Built-in B
B Reports v R
d BS FortiPortal User Summary Report English Previous 7 Days All Devices (™ Built-in B
Generated Reports .
B B O B Security Events and Incidents Summary English Previous 7 Days All_FortiGat (™ Built-in B
eport Definitions
Advanced Settings BS Shadow-Al Report English This Month All Devices (™ Built-in B
(] BS situation Awareness Report English Previous 7 Days All Devices (™ Built-in B

# System Settings

(™ FAZVM_025

The report template can be found in Reports > Report Definitions > Templates.

Description =

FTESETIL d DIET SUTmdry U1 ure eVETLS/ ImCiaernts conecea.
Self-Harm and Risk Indicators Report.
Present a brief summary report about cloud-based services.

port highlights organizational Al adoption, with a focus on sanctioned versus unsanctioned us

le awareness of your current security posture, and allow for a better understanding of the 'big [
t a brief summary report about SOC 2 Compliance Report.

t a brief summary of SOC Incidents.

@ Dashboards » AllReports ERENIEICS Chart Library Macro Library Datasets
@ Device Manager + Create New
Title ¢ La.. =
FortiView > m te 2
J E 1empiate - Security tvents ana inciaents sum €l
m Log View > [J B Template - Self-Harm and Risk Indicators Rep en
- & Template - Shadow IT Report en
Fabric View > U P P
=] Template - Shadow-Al Report en This re
BY Incidents & Alerts > ® View
[(m =] Template - Situation Awareness Rep
. T Delete
© FortiAl > O @ Template - SOC 2 Compliance Repd|
% Clone
[ Template - SOC Incident Report
B Reports - 0 P P By Create Report
=1 e )
Generated Reports [0 B Template - Social Media Usage Report e
Report Definitions [0 B Template - Threat Report en
Advanced Settings [0 B Template - Throughput Utilization Billing by C en
’ System Settings > — Fl Tamnlata - Thrauchout LiSlization Rilling Dan_an

socrar Media Usage Report.
Malware, Botnets - detected, victims and sources. Intrusions detected, sources, blocked severity and
Interface Throughput Utilization Billing by Device and Interface Report.

Intarfaca Thrauahnut | 4lizatian Rilling Danart

The datasets (shadowai) used for the report can be found in Reports > Report Definitions > Datasets.

@ Dashboards » AllReports | Templates Chart Library Macro Library
&m Device Manager
Name ¢
E FortiView > O
O & shadowai-Adoption-Growth-Trend
m Log View > -
[0 = shadowai-Al-App-Count
Fabric View > [0 & shadowai-Al-Use-Case
Incidents & Alerts , O £= shadowai-Al-Use-Case-By-App-Sanction-Status
O = shadowai-Top-Al-App-User-By-Dlp
I©® FortiAl S
O & shadowai-Top-Sanctioned-Al-App-By-User
E RepOis v O & shadowai-Top-Unsanctioned-Al-App-By-User
Caneri=d) RS O & shadowai-Top-Unsanctioned-Al-App-User-By-Usage

Report Definitions

FortiAnalyzer 8.0.0 New Features Guide
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View Options v

Datasets

shadowai

Device Type = Log Type = Origin & n
Fabric Normalized (™ Built-in
Fabric Normalized (™ Built-in
Fabric Normalized (™ Built-in
Fabric Normalized (™ Built-in
Fabric Normalized (™ Built-in
Fabric Normalized (™ Built-in
Fabric Normalized (™ Built-in
Fabric Normalized (™ Built-in
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Log and Report

The charts used for the report can be found in Reports > Report Definitions > Chart Library.

(™ FAZVM_025 = Q-

@ Dashboards 3> | All Reports Macro Library | Datasets

Templates EEEARLIE1Y

= Device Manager View Options v Al @ .F
Name ¢ Description ¢ Device Type &  Category < [«
E FortiView > a a 2 ey :
O @ Security Rating SOC 2 Sub Compliance Failed Statistics Recommendatiol Security Rating SOC 2 Sub Compliance Failed St FortiGate Normalized
m Log View > » L A L . R .
(] I SIEM-Al Applications Adoption Growth Trend Al Applications Adoption Growth Trend Fabric Normalized
(@) Fabric View > [0 € SIEM-Top 5 Al Application Use Cases Top 5 Al Application Use Cases Fabric Normalized
B Incidents & Alerts N [0 = SIEM-Top 5 Al Application Use Cases By App Sanction Status Top 5 Al Application Use Cases By App Sanction Fabric Normalized
a B SIEM-Top 5 Al Application Users By DLP Incident Top 5 Al Application Users By DLP Incident Fabric Normalized
© FortiAl >
(] 5] SIEM-Top 5 Sanctioned Al Applications By User Top 5 Sanctioned Al Applications By User Fabric Normalized
| E Reports ¥ [ [ESIEM-Top 5 Unsanctioned Al Application Users By Usage Top 5 Unsanctioned Al Application Users By Usz Fabric Normalized
Generated Reports O B SIEM-Top 5 Unsanctioned Al Applications By User Top 5 Unsanctioned Al Applications By User Fabric Normalized
R t Definiti
O € SIEM-Total Number of Al Applications Detected Total Number of Al Applications Detected Fabric Normalized
Advanced Settings
(] B Top 10 Botnet by Domain Top 10 Botnet by Domain FortiGate DNS

# Sustem Settines >

Below is a brief sample of the report in PDF format.

Shadow-Al Report
Data Range: 2026-04-01 00:00:00 2026-04-28 15:58:18PDT

RTINET

EXECUTIVE SUMMARY

This report highlights organizational Al adoption, with a focus on sanctioned versus unsanctioned usage, top applications, and user activity. The analysis identifies the most widely
used apps, key users driving adoption, and potential risks where sensitive data may be involved. Trends show overall growth in Al usage, compliance gaps between sanctioned and
non-compliant apps, and risk exposure by application type. These insights support stronger governance, policy alignment, and risk mitigation.

GEN Al APPLICATION INVENTORY

TOTAL NUMBER OF Al APPLICATIONS DETECTED TOP Al USE CASES

® Sanctioned: 114

138 ® Unsanctioned: 24

® Productivity Assistant: 27.57%

® Image Genesator: 23.59%

® Conversational Assistant: 18.19%
Writing Assistant: 12 22%

@ Video Generator: 9.14%

Others: 9.3%

TOP Al APPLICATONS

TOP 5 Al APPLICATONS (UNSANCTIONED)

2

< Slidesgo Productivity Assistant Medium
ance. mage Generator ium

\'% Al Image Gen Medi 2
onversational Assistant ium

H HARPA.AI C ional Assi Medi 2
inkAn onversational Assistant ium

ThinkAny C ional Assi Medi 2
eechmatics udio Generator ium

0 Speechmati Audio G Medi 2

page10f3
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Shadow-Al Report =:ATINET

-
Data Range: 2026-04-01 00:00:00 2026-04-28 15:58:18PDT

TOP 5 Al APPLICATONS (SANCTIONED)

4 Google.Gemini Conversational Assistant Info

& OpenAl.ChatGPT Conversational Assistant @ Info 4
@® Canva Image Generator Medium 3
= CapCut Video Generator Medium 3
g DeeplL Productivity Assistant o Info 3

TOP 5 USERS BY Al USAGE (UNSANCTIONED)

_ Most Used Application Detection Source(s) Top Risk Level

useré @® Grammarly 7.854 Application Control Medium
user5s @® Grammarly 2,766 Application Control Medium
not_me & DeepL 219 Application Control Medium

TOP 5 USERS BY DATA LOSS PREVENTION INCIDENTS

No matching log data for this report

page2of 3
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Shadow-Al Report

Data Range: 2026-04-01 00:00:00 2026-04-28 15:58:18PDT

ADOPTION GROWTH TREND
@ Sanctioned Al Application @ Unsanctioned Al Application

30K

20K

Usage

04-27

04-01 04-03 04-05 04-07 04-09 04-11

Al APPLICATION USAGE BY TYPE
M Sanctioned Al Application M Unsanctioned Al Application

Enterprise Search  Meeting Assistant

Code Assistant Audio Generator

Productivity Assistant Image Generator  Conversational Assistant  Writing Assistant Video Generator

page 30f 3

FortiAnalyzer 8.0.0 New Features Guide
Fortinet Inc.

52



FortiAl

This section lists the new features added to FortiAnalyzer for FortiAl:

e FortiAl alert triage agent on page 53
» FortiAl threat posture timeline on page 55

FortiAl alert triage agent

Ly

g This information is also available in the FortiAnalyzer 8.0 Administration Guide:

e Alert triage agent

The new Triage Agent leverages agentic Al to support SOC analysts in triaging alerts and performing next steps
from within the FortiAnalyzer GUI. The goal is to reduce investigation time, enhance correlation accuracy, and
give customers immediate awareness without manual log searching or cross-device analysis.

To use the alert triage agent:

1. Gotolncidents & Alerts > Alerts.
2. Right-click an alert and, form the shortcut menu, click Details.

FAZ-202-Al

ADOM:root >~ @+ © () admin ~

B Device Manager AllDevicesv @Al v @Refresh v @View Options
Alert s © Host 2177 @ Source 1 @ Target 2175 @ User 1597 @
Search Filter Search Filter Search Filter Search Fiter Search Filter
High Severity Events Handler 5064 133 0| na 11115 540 176 §
Fabric View
High Severity alerts Handler 5058 54 37 37
[E¥ incidents & Alerts ZTNA Brute Force Login 309 37 25 25
. Anornaly Login Detection 256 36 24 24
Alerts Risky App Detection by Threat 200 24 24 24
Alert Handlers Risky App Detection by Source Endpoint 200 18 18 18
Alert Collectors: Local Device Event 17 17 18 18
hcatony Related Alerts Search a -
FortiGuard Services
S @ | Severitys  LastOccureds | Alerts Source + Target User & Details & Devlu
Log Parsers 9 minutes ago endpoint: 12 endpoint: FGT37[|
O Fortial o 9 minutes ago endpoint:172.16.76.204 8 Details endpoint: FG101E
o 9 minutes ago endpoint: O searchin Log View endpoint: FG101E
B Reports o &1 Create New Incident
9 minutes ago endpoint: endpoint: 4+ FG101E
8 System Settings o 9 minutes ago endpoint: & Add o Eising Incident dpoint: + FG101E
: en
. P < Suppress oo
[m] 9 minutes ago endpoint: endpoint: > FG101E
[m] 9 minutes ago endpoint: endpoint: FG101E
[m} 9 minutes ago endpoint: endpoint: FG101E
o 9 minutes ago endpoint: endpoint: 0% 50 ) 01¢

Alternatively, you can double-click the alert to open the Alert details.
3. Inthe Alert details, go to the Triage Agent tab.
4. Wait for the FortiAl Reasoning Agent to finish the analysis, including:

FortiAnalyzer 8.0.0 New Features Guide
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e Get Alert Details

e Get Triggering Logs
e Get Entity Details
e Get Alert Context

» Triage Analysis
« Next Steps
(™ Faz-202-A1 = Q-

@ Dashboards

&5 Device Manager

[ Log View

@ Fabric View o~

[ Incidents &Alerts
Incidents
Alerts
Alert Handlers
Alert Collectors
Indicators
FortiGuard Services
Automation

Log Parsers

& Fortial
B Reports

¥ System Settings

12

1. Get Alert Details

Summary: High Severity Events Rule flagged a DNS
resolution error from endpoint 0 to
external IP on port 53, classified
as Malware . The source is a reserved address while
the destination is in the Netherlands, indicating a
potentially malicious domain lookup. igati

Aert Details [PERLE o] Triggering Logs  Timeline

Sy
P
| sz scnnczncre

C Replay

P
S| 206,042 140559 12 minses )

should verify whether this is a malware
command-and-control attempt or a benign
misconfiguration.

Hypotheses:

+ Malware on the endpoint is using DNS
tunneling to communicate with a C2 server at 1

+ The endpoint attempted to resolve a malicious
domain that was blocked, generating a DNS
error.

+ The DNS query was part of a data exfiltration
attempt via DNS.

+ Internal DNS server misconfigured, causing a

lagitimate dnmain n fail

i Ca s, DN oy B et
s —

£
L]

ii
L]

g
§

i

i
‘i
i

Monthly token:

5. Review the Al reasoning by clicking on the steps within the FortiAl Reasoning Agent window.
6. From the Next Steps window, select the next step to perform on the alert.

For example:

e Save Summary as PDF

triage_report_202604211000039475.pdlf

e Create New Incident

FortiAnalyzer 8.0.0 New Features Guide
Fortinet Inc.

F::RTINET

endpoint:

Alert ID: 202604211000039475

Trigger Name: High Severity Events Handler
Rule Name: High Severity Events Rule

Triage Investigation Report
2026-04-21

1. Get Alert Details

Summary: The alert High Severity Events Rule flagged a SSL Fatal Alert received from endpoint to
external on port 443. The source geo is Reserved, indicating internal or unknown origin, while the
destination is in Chile. This suggests a failed TLS handshake from an internal host to an external server, warranting
investigation into certificate validity or malicious activity.

Hypothese:
True por

1. The endpoint attempted to connect to a malicious server with an invalid or expired certificate, causing a fatal alert.
2. Malware on the endpoint s trying via HTTPS but the TL fails dlue t

attack.
3. Amisconfigured VPN client on the endpoint is generating a fatal SSL alert during connection establishment.

False positi

1. Alegii uses a self2signed certif
failure.

2. Network monitoring software misintery 17LS fatal alert.

3. A benign firewall rule logs a false SSL alert during routine traffic inspection.

, triggering the alert on a harmless handshake

2. Get Triggering Logs

‘Summary: An internal host at src_ip attempted an HTTPS connection to dst_ip
where the FortiGate WAF logged a fatal SSL alert received. The alert originates from a reserved internal location and

shows no failed authentication, indicating a handshake failure rather than a login issue. The data points toward either a

ora ion on the internal client.
Insight:

« True positive 1: The endpoint attempted to connect to a malicious server with an invalid or expired certificate,
causing a fatal alert.
itive 2: Malware on int is trying

1 in Chile,

via HTTPS but the TLS handshake fails due to a
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Create New Incident

Incident Name
Incident Category
MITRE Tech ID
Severity

Status

Affected Endpoint

Description

Assigned To

« Add to Existing Incident

Attach to Incident
Incident Number

QAlv
Incident Number + | Name &
IN00002864
IN00002863
IN00002862
IN00002861
IN00002860
IN00002859
IN00002858
IN00002857
IN00002856
IN00002855

IN00002854.

High Severity Events Handler happened at
Uncategorized
Click to select
High
New
12

High Severity Events Handler happened at

Click to select

Cancel

IN00002863

Search

Incident Date / Time + | Last Update Date / Time | Incident Reporter & Incident Category

Severity & | Status n
High
High
High

2026-04-18 13:25:13 | 2026-04-18 13:25:36 202604181000033172  Denial of Service (DoS) New

2026-04-17 21:15:33 | 2026-04-17 21:15:33 Malicious Code

2026-04-17 20:58:54  2026-04-17 20:58:54 Unauthorized Access

2026-04-17 13:08:08 | 2026-04-20 16:10:36 202604171000040405  Malicious Code Medium

2026-04-17 13:08:04 | 2026-04-20 16:10:36 202604171000040403  Denial of Service (DoS) | High

2026-04-14 19:20.00 | 2026-04-21 06:20:29 202604141000064277  Denial of Service (DoS) | High

2026-04-14 19:20.00 | 2026-04-21 06:20:29 202604141000064276  Denial of Service (DoS) | High

2026-04-14 19:20.00 | 2026-04-21 06:20:29 202604141000064275  Denial of Service (DoS) | High

2026-04-14 19:20.00 | 2026-04-21 06:20:30 202604141000064268  Denial of Service (DoS) | High

2026-04-14 19:20.00 | 2026-04-21 06:20:29 202604141000064269  Denial of Service (DoS) | High

2026-04-14 19:20:00 _2026-04-21 06:20:30 202604141000064267_ Denial of Service (DoS) | High

Total Selected: 1

Other next step actions can include Suppress Alert and Create Indicator & Block IP, depending on

1000

v /Page

recommendations from the agent and available connectors.

FortiAl threat posture timeline

? This information is also available in the FortiAnalyzer 8.0 Administration Guide:

e FortiAl threat posture timeline

FortiAnalyzer 8.0.0 New Features Guide
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FortiAl

The new FortiAl Threat Posture Timeline provides an automated, consolidated security assessment for any
asset or user identity. By aggregating UTM logs, alerts, incidents, and behavioral indicators from multiple

sources (FortiGate, FortiClient, FortiMail, FortiAuthenticator), the system uses Al to determine the current threat
posture, detect developing risks, and surface contextual insights.

To use the FortiAl threat posture timeline:

1. Inthe FortiAnalyzer GUI, go to Fabric View > Asset Identity Center > Asset Identity List.

2. Right-click an endpoint and, from the shortcut menu, select Open FortiAl Threat Posture Timeline.

(™ FAZ-202-A1
@ Dashboards
B8 Device Manager
& Fortiview

M Log View

B Fabric View

Asset Identity Center

Subnets

Incidents & Alerts
& FortiAl
B Reports

¥ System Settings

FATINET - o

Alternatively, open the endpoint details and click Threat Posture Timeline.

(™ FAZ-202-A1
@ Dashboards

0 Device Manager
& Fortiview

[ Log View

@ Fabric View

Asset Identity Center

Subnets

Incidents & Alerts

© FortiAl

B Reports

¥ System Settings

[STRUEI Asset Identity List

ADOM:rcot >~ @~ © (@) aumin

© Last 30 Minutes v 2026-04-21 14:45:40 - 2026-04-21 14:4540 | 4 Create Gustom View | [ Data Sources || 4, Download | [ G Reload ] Asset v

Top 10 Risky Assets
Iy Lo
a8
Iy IF5GG
Iy pC1
Iy NB1
A local
= ub
&
Iy )
A 17BB6
EndpointId + | Endpoint Name &
1082
44085 L0
44079 F5GG
44083 PCL
44081 NB1
1084 local
45173 - ~ club

1118

44062
Total Selected: 1

Lo Regular Asset  First seen: 2026-03-24 16:1005 »

Top 10 Vulnerable Assets

1

[ =

QOT/leT Vulnerabilities | Tags = IP Address =

User Risk Score & ilities <
G Regular Asset oDE» = €&
LG Regular Asset -
LG Regular Asset -
5 Regular Asset -
L0 Regular Asset -
L0 Regular Asset. {1 1

@ Search "Endpoint Name = mail.vbs-ocommunitysde.club”
@ Search "Endpoint Name != mail.vbs-ocommunitysde.club"
& Open FortiAl Threat Posture Timeline

3 Show in OT view

club

g0

Crifical Vuins

System Properties

Endpoint ID.
45173

Host Name

Detection Type

By_fetuid

Last Seen

2026-04-21 14:52:08 (3 minutes ago)

Source
FCTEMS

default FGI01E:

Users (1)

Score

84/100

Last active: 3 minutes ago

High Valns
1P Address
Detection Key
FortiClient UUID
rotport2  FGVM root port2
First seen Last seen
Mar 24,2026 4hours ago 4

IF5GG
-LT0
-NB1L

-PC1

local

MAC Address +

Hardware / OS &

Windows

103
- &
- &

[ s ]
[ 2 ]

Last Update n

2026-04-21 14:21:50 '
2026-04-2114:21:36
2026-04-2114:21:36
2026-04-21 14:21:35
2026-04-21 14:21:36
2026-04-2114:21:52
2026-04-21 14:37:02
2026-04-21 14:40:09

2026-04-21 14:21:13
0% 100

ADOM:root >- @+ & () amin~

27.8 .03
-

Associated Users

Timeline

Threat
© Posture

MAC Address

05 Name
Windows

2026-03-24 16:10:05.

Search

3. Wait for Al Agent analysis to finish. Review the analysis result in the FortiAl Endpoint Analysis Agent pane.

The endpoint threats are highlighted at the bottom, below the timeline.
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™ Faz202-A1

@ Dashboards

2 Device Manager
B Fortiview

[ Log View

Fabric View

Asset Identity Center

Subnets

Incidents & Alerts
© FortiAl
B Reports

#¥ System Settings

™ FAZ-202-A1

@ Dashboards

25 Device Manager

FortiView

M Log View
Fabric View

Asset Identity Center

Subnets

Incidents & Alerts
© Fortial
B Reports

¥ System Settings

Fi:RTINET

Mouse over the

FortiAl Threat Posture Timeline -

© Last 1 Day v

Last 1 Day
Jt/Received
e

Last 3 Days

.club

2026-04-20 14:46:35 - 2026-04-21 14:46:35

Last1Week 8

Last N Days /
3

Last N Weeks /
Custom...

8
3768 I

ADOM:root >~ @~ © °admln

QIEUTS Sessions | Threat Score

@ v Summary

Summary

The logs point to a single internal host ( ) that
was compromised by a botnet (Mirai, Remcos, IcedID).
During the 14:54-15:00 h window, the host attempted to

with known C2 servers, exfiltrated large
amounts of data, and probed for additional vulnerabilities

1 More v

28ce (Spring deserialization). The activity pattern is consistent
with a staged attack: reconnaissance (EICAR tests),
1ees exploitation (Spring deserialization), lateral
movement/exfiltration, and sustained C2 communication.
953.7 MB
dmsint lags, user activity, and
[y e 207000 2| FGT - Mirai Botnet FGT - Mirai.Botnet FGT - Remcos.Botnet  FGT - IcedID.Botnet 3 More... H confirm whether the host
Time: 2026-04-21 Time: 2026-04-21 Time: 2026-04-21 Time: 2026-04-21 traffic was legitimate.
00:03:15 00:03:15 00:03:15 00:03:15
=@ Last Log Time: 2026-04- Last Log Time: 2026-04-  Last Log Time: 2026-04- Last Log Time: 2026-04-
Apr2016:00 Apr 20 20:00 402 21142112 21142112 21142112 211421:12 =
Log Count: 104 Log Count: 52 Log Count: 52 Log Count: 52
Command & Control - Botnet Endpoint ID: 45173 Endpoint ID: 45173 Endpoint ID: 45173 Endpoint fiity Scanning

Severity: high
Description: The same internal IP (

) triggers Mirai, Remcos,

Source IP:

Source IP:

Source IP:

5173

Source IP:

botnet alerts across several interfaces. This pattern is
that is both receiving commands and attempting to spread.

Message: backdoor:

eah 1P: Destination IP: 1p:
Hostname: Hostname: Severity: alert Hostname:
Message: backdoor:  Severity: alert
Severity: alert Severity: alert Remcos.Botnet
Message: backdoor: Message: backdoor: IcedID.Botnet
Mirai.Botnet Mirai.Botnet

for known vulnerabilities and
h EICAR files, a common technique
lcontrols.

Log Type &

Date/Ti..

2026-04-2...

2026-04-2...

2026-04-2...

2026-04-2...

2026-04-2...

2026-04-2...

2026-04-2...

Alerts & Logs - Command & Control - Botnet

URL =

User +

ADOM:root >— @~ O Oadmlnv

egi-bin/.%... I:l Mirai.Botnet

Jegi-bin/ 9.

/
/

J2class.mo...
Jegi-bin/ %...

Jegi-bin/ 3.

Total Selected: 1

- x
Message & Level & Device ID ¢ Severin
alert FGVWW  high
backdoor: Mirai.Botnet alert FGWV high
backdoor: lcediD.Botnet | alert FGWV. high
backdoor: lcedID.Botnet | alert FGVV high
web_app3: Spring Framew... | alert FGWV critical
backdoor: Mirai.Botnet alert FGWV high
backdoor: Mirai.Botnet alert FGWV. high
7

5. From the More dropdown, you can proceed with next steps, such as exporting the PDF to share with other
SOC analysts, creating a new incident, or adding to an existing incident.
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Create New Incident

Incident Name
Incident Category
MITRE Tech ID
Severity

Status

Affected Endpoint

Description

Assigned To

Attach to Incident

Incident Number

[ TV
Incident Number ¢ | Name %
IN00002864
INO0002863
IN00002862
IN00002861
IN00002860
IN00002859
IN00002858
IN00002857
IN00002856
IN00002855

IN00002854

Uncategorized
Click to select
Medium

New

N/A

Not Assigned

IN00002863

Incident Date / Time &
2026-04-18 13:25:13
2026-04-17 21:15:33
2026-04-17 20:58:54
2026-04-17 13:08:08
2026-04-17 13:08:04
2026-04-14 19:20:00
2026-04-14 19:20:00
2026-04-14 19:20:00
2026-04-14 19:20:00
2026-04-14 19:20:00

2026-04-14 19:20:00

Last Update Date / Time &
2026-04-18 13:25:36
2026-04-17 21:15:33
2026-04-17 20:58:54
2026-04-20 16:10:36
2026-04-20 16:10:36
2026-04-21 06:20:29
2026-04-21 06:20:29
2026-04-21 06:20:29
2026-04-21 06:20:30
2026-04-2106:20:29

2026-04-21 06:20:30

Search

Incident Reporter &

202604181000033172

Incident Category &

Denial of Service (DoS)

T e

202604171000040405

202604171000040403

202604141000064277

202604141000064276

202604141000064275

202604141000064268

202604141000064269

202604141000064267

Total Selected: 1
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1000 - /Page

Unauthorized Access

Malicious Code
Denial of Service (DoS)
Denial of Service (DoS)
Denial of Service (DoS)
Denial of Service (DoS)
Denial of Service (DoS)
Denial of Service (DoS)

Denial of Service (DoS)

Cancel

Severity ¢ | Status a

High New |9
High

High

Medium
High
High
High
High
High
High

High
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System

This section lists the new features added to FortiAnalyzer for system settings:

¢ Others on page 59
» FortiAnalyzer Fabric on page 68

Others

This section lists the new features added to FortiAnalyzer for other features relating to system settings:

e Legal third party disclosure panel on page 59

» Custom session labels in FortiAnalyzer event logs on page 61

e SAML SSO supports SHA-256 and SHA-512 for both IdP and SP on page 65

» Time-base retention is configurable for the task monitor and event log on page 68

Legal third party disclosure panel

A Legal Third Party panel is added to the GUI, providing a searchable and exportable list of all third-party
software used in FortiAnalyzer, along with their required licenses, license terms, and version information. This
centralizes all third-party licensing details in one single, easily accessible location.
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To access and use the third-party software list:

1. Select the user name > System > Legal Third Party to open the Included Third Party Software list.

B FAZVM64-KVM =

Q -
Toggle Widget v

System Information

@ D

hboard:

Status

Firmware Version

Up Time

FortiAnalyzer Cloud Status

FRATINET

Entitled Usage: 0 GB/Day

Host Name FAZVM64-KVM

Serial Number FAZ-wwssrrensss

Platform Type FAZVM&4-KVM

HA Status Standalone

System Time Thu Feb 19 15:32:21 2026 PST

v8.0.0 build0041 (Interim)
System Configuration Last Backup: N/A
Current Administrat... admin / 2 in total

3 minutes 47 seconds

@

FortiAnalyzer Cloud Unavailable

Used: 0 GB/Day

mn
<

)

[

&

B 4

>> @ ot o @aomn-

A admin

FortiAnalyzer-VM64-KVM
v8.0.0 build0061 (Interim}
& Upgrade Firmware
Ty Legal Third Party
|~ Process Monitor
& Change Password
¢ Change Profile
@ Log Out

2. Hover over the License terms field to display additional information about the license terms.

FAZVM64-KVM

© FortiAl
B rej
&

FZERTINET

3. Click Export to export the list in the CSV, JSON, or CycloneDX SBOM JSON format.
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Included Third Party Software

Name =

3ware-9550sx-u-firmware
@dagrejs/dagre
@dnd-kit/core
@floating-ui/react
@leeoniya/ufuzzy
@lit-labs/react
@popperjs/care
@reduxjs/toolkit
@shoelace-style/animations
@shoelace-style/shoelace
@xyflow/react

Airflow

Apache HTTP Server
app-datepicker

argparse

Search... @ *
Version & License = u
2.26.02.007 GNU General Public License v2.0 enly
114 MIT License
610 MIT License |
0.27.1 MIT License
1.0.14

121
211
197
1.20
2.0.0-
12.3.6
2.10.5
2.4.2¢
4.5.3

201

Copyright (c) 2021, Claudéric Demers.

Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the "Software"), to deal in the
Software without restriction, including without limitation the rights to use, copy,
modify, merge, publish, distribute, sublicense, and/or sell copies of the Software,
and to permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, |
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES
OF MERCHANTARBILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALLTHE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE

OR OTHER DEALINGS IN THE SOFTWARE. 0% 177

Close
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ZVMéE4-KVM > 0 - [3 2 @ ° admin -
Included Third Party Software x
B Export v Search @ J*
csv Version License = u
JSON 2.26.02.007 GNU General Public License v2.0 only
CycloneDX SBOM JSON 114 MIT License
@dnd-kit/core 610 MIT License
@floating-ui/react 0.27.16 MIT License
@leeoniya/ufuzzy 10.14 MIT License
@lit-labs/react 121 BSD 3-Clause "New" or "Revised" License
@popperjs/core 2118 MIT License
B Incidents & Alerts i @reduxjs/toolkit 19.7 MIT License
© Fortial @shoelace-style/animations 120 MIT License
@shoelace-style/shoelace 2.0.0-beta.13 MIT License
@xyflow/react 12.3.6 MIT License
Airflow 2105 Apache License 2.0
Apache HTTP Server 24.25 Apache License 2.0
app-datepicker 453 MIT License
argparse 201 Python License 2.0
0% 177

FATINET Close
8.0, V]

4. Click on the third party software name to open that product's information page in your browser.

Q - [m] (¢] QO B litdev

™ 164-KVM ® signin &1 =

Included Third Party Software

Status

Dasht

A Lit is now part of the OpenJS Foundation! Read our announcement.

W Lit

Simple. Fast. Web Components.

Name %

3ware-9550sx-u-firmware

@dagrejs/dagre

@dnd-kit/core

@floating-ui/react

@leeoniya/ufuzzy
@lit-labs/react
@popperjs/core
@reduxjs/toolkit

© FortiAl @shoelace-style/animations
ortiA\

@shoelace-style/shoelace

B Reports @xyflow/react

> npm i 1lit

Get Started

s 5 < Airflow
Apache HTTP Server

app-datepicker

argparse

FRTINET 8.0

Custom session labels in FortiAnalyzer event logs

FortiAnalyzer supports the ability to set custom session labels.

When a custom session label is set, all actions performed by the administrator during that session will be tagged
with the session label in the Event Log.

The custom session label feature can be enabled using the FortiAnalyzer CLI. By default, this feature is disabled.

When enabled, you can set the session label mode as one of the following options:
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» Changeable: The custom session label can be changed during an active session (default).

» Unique per-session: After a custom session label has been set, it cannot be changed until the session is
terminated.

When custom session labels are enabled, it is mandatory for an administrator to set a custom session
label.

Unique session labels are not enforced, which means it is possible to have multiple sessions with the
same session label.

To use custom session labels:
1. Enable custom session labels in the FortiAnalyzer CLI:
config system admin setting
set custom-session-label enable

set custom-session-label-mode {changeable | unique-per-session}
end

2. Login to the FortiAnalyzer GUI.
Administrators will see a Set Custom Session Label dialog after successfully logging in to FortiAnalyzer.

Set Custom Session Label

Please set a custom session label. It will be used to identify all admin actions in the Event Log.

Custom Session Label

3. Enteryourlogin credentials and enter a custom session label, then click Login. Custom session labels can

be up to 36 characters in length.
When there are multiple logins from the same administrator, different custom session labels can be used to

distinguish the sessions.
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Set Session Identification

Session Identification Session1

Please set a session identifier. It will be used to identify all admin actions in the Event Log.

8/36

Set Session Identification =]

Please set a session identifier. It will be used to identify all admin actions in the Event Log.

Session Identification Session2

8/36

4. View a list of active sessions by going to Dashboard and clicking on the Current Session List icon in the

System Information widget.

The custom session labels for active users are displayed.

F=:RTINET vB.0.0

Admin Session List

O | User Name % Profile & IP Address = Current ADOM %
[m} A admin (Current) Super_User GUI(192.168.122.1) root
(] A admin Super_User GUI(192.168.122.1) root

Close

- @ N2 & @aimn-

search... @ >
Custom Session Label + | Start Time eu
session2 Wed Feb 25 09:

sessionl Wed Feb 25 09:

5. Goto System Settings > Event Logs and review the Custom Session ID column to see the session label

associated with each event.
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FAZVM64-KVM = q > @ N2 @ @ aomn-

ﬂI] @ Last 1 Hour v 08:39:20 - 09:39:20 11 Full Screen ‘ |.¢3 Refresh ‘ i More v ‘
o ale
abric V
& Date/Tim¢ | Device ID ADOM Sub Type User Message Operation Performed ... Changes | Custom Session Label E
Lo s 2026-02-250 nja fortism nfa [FORTISM Violation: domain= open_r /data/.uvid bit open_r on /da
© Fortial 2026-02-250 = nfa fortism n/a [FORTISM Violation: domain= open_r /data/.uuid.bir open_r on /da
E Reports 2026-02-250 J root dvm admin Successfully lc root ‘admin’ succes sessionl
2026-02-250 | root system admin User 'admin’ with profile ‘Supt login GUI(192.168.: "admin’ login a sessionl
2026-02-250 g system system System performance status: |t Perf stats Local system = Show system |
2026-02-250 | nfa fortism n/a [FORTISM Violation: domain: open_r /data/.uuid.bit open_r on /da
2026-02-250 = in/a fortism nfa [FORTISM Violation: domain= open_r /data/.uuid.bir open_r on /da
2026-02-250 | root dvm admin Successfully Ic root ‘admin’ succes session2
2026-02-250 / root system admin User 'admin’ with profile ‘Supe login GUI(192.168.; 'admin’ login a session2
10 | 2026-02-250 g system system System performance status: |t Perf stats Local system = Show system |
11 | 2026-02-250 | root system admin User 'admin’ with profile "Supt logout GUI(192.168.: "admin’ logout
12 | 2026-02-250 L system admin edit console path=system.z
13 | 2026-02-250 ) system admin User 'admin’ with profile 'Sup¢ login console ‘admin’ login a
14 | 2026-02-250 | nfa fortism n/a [FORTISM Violation: domain= open_r /data/.uuid.bir open_r on /da
15 | 2026-02-250 J root dvm admin Successfully lc root ‘admin’ succes

£2 Total logs for analysis: 13 days 22 hours 50 v /Page

A 0.30 seconds

Change an active custom session label

When changeable mode is enabled, administrators can change their custom session label during an active
session using one of the following methods.

To change an active session's label:

1. Inthe System Information widget's Current Session List menu, select the administrator and click Edit
Custom Session Label.

ADOM:76ADOM >_ @~ A ° & °admm-

Edit Custom Session Label ®

F-:RATINET Cancel
p

2. Inthe toolbar's administrator dropdown menu, click Custom Session Label.
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ADOM:76ADOM  >_ @~ L[ °* © oadminv

Edit Custom Session Label A admin

- FortiAnalyzer-VMé4-KVM
v8.0.0 build0084 (Interim)

Custom Session Label Session 1

& Upgrade Firmware
[# Custom Session Label
Ty Legal Third Party

|~ Process Monitor

& Change Password

£ Change Profile
@ Log Out

F=:ATINET Cancel

After changing the session label, you can see the updated session label in the Current Session List.

SAML SSO supports SHA-256 and SHA-512 for both IdP
and SP

[
s,

g This information is also available in the FortiAnalyzer 8.0 Administration Guide:
¢ SAML admin authentication

SAML SSO configurations on FortiAnalyzer support SHA-256 and SHA-512.

SHA-1is considered cryptographically weak and has been deprecated for secure digital signatures and digests.
Support for SHA-1 on FortiAnalyzer has been removed.

When configuring IdP and SP settings on FortiAnalyzer, administrators can select SHA-256 or SHA-512 for the
Signature Algorithm and Digest Method. Because the SAML SSO trust model is based on asymmetric
cryptography, the IdP and SP can use different cryptographic algorithms.

For example, when the IdP uses SHA-256 as the Signature Algorithm and Digest Method, the SP can use SHA-
256 or SHA-512.

To configure the Signature Algorithm and Digest Method for SAML SSO:

Go to System Settings > SAML SSO.

Select Identity Provider (IdP) or Service Provider (SP) as the Single Sign-On Mode.
Choose an IdP Certificate or SP Certificate.

Select the Signature Algorithm as RSA-SHA256 or RSA-SHA512.

Select the Digest Method as SHA256 or SHA512.

a bk 0N =

FortiAnalyzer 8.0.0 New Features Guide 65
Fortinet Inc.


https://docs.fortinet.com/document/fortianalyzer/8.0.0/administration-guide/981386/saml-admin-authentication

System

= Q- > @ N2 S @ admin-
Single Sign-On Settings

Server Address @

Allow admins to login with FortiCloud @ o

Single Sign-On Mode Disabled BUENTWAZIWVRSRIGIIY Service Provider (SP) | Fabric SP

1dP Certificate Click to select e

Signature Algorithm LIRTIVETY RSA-SHAS12
Digest Method ERTVE SHAS12

. Login Page Template o
© FortiAl ein Pag
SP Settings
B Reports
#¥ System Settings Search... @
ADOMs O | Neme® Entity ID & u

No record found.

Admin Profiles [
Authenti

abric Management

SAMLSSO

Settings

™ Faz = Q- > @ N2 S @ admin-

@ Dashboards Single Sign-On Settings

Server Address @ =
Allow admins to login with FortiCloud @ o

Single Sign-On Mode Disabled | Identity Provider (1dP) JESRISA s SAEHY Fabric SP

@ 'n SPmode, an SSO administrator is associated with each user who logs in via SSO. You can edit their profiles on the Administrators page.

Custom SP Entity ID @ o
SP Entity ID & Copy
SPACS (Login) URL = ™ Copy
SP SLS (Logout) URL
B Reports & @ Copy
SP Certificate fortidemo (DigiCert, * fortidemo.fortinet.com) % v & Download
£ System Settings Signature Algorithm RSA-SHA256 N IP)
ADOMs Digest Method sHA256 TNEE)
Administrators View SP Metadata © View
Admin Pr Default Login Page @ m Single-Sign On
Remote Authentication .. Auto Create Admin @ o
Fabric Management
Signing Options
SAMLSSO
[T Authentication Request Signed @ o
Logout Request Signed @ o
Require Assertions Signed from IdP o
Dariica I it Dacnanea Sinnad ~

F::ATINET Apply

6. Configure the remaining settings as required and click Apply.

FortiAnalyzer supports NTPv4 with SHA-256 encryption

FortiAnalyzer supports NTPv4 with SHA-256 encryption.

Example: Configuring an NTPv4 server with SHA-256 encryption on FortiAnalyzer:

1. Create a Chrony server in Linux and change the following files:
/etc/chrony.conf

Allow <FortiAnalyzer gateway>
Bindaddress <internal IP of the linux>
Make sure keyfile is not commented

/etc/chrony.keys
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123 SHA256 HEX:f3c79b2288a249f8a218646af0492706014fc9f4beb58fd3b6aa6d45782dd6ca
222 SHA256 somepassword
<key id> <ENC algorithm> <key>

Oy

? The value 7123 in the example above must match the key-id defined in the FortiAnalyzer
configuration, and the hex key must also match exactly.

2. Configure the NTP server settings on FortiAnalyzer in the CLI:

config system ntp
config ntpserver
edit <server name>
set server <hostname/IP>
set authentication enable
set key-type sha256
set key-fmt <hex/ascii>
set key <hex/ascii string>
set key-id <key ID for authentication>
next
end
end

» Example Using HEX

config system ntp
config ntpserver
edit serverl
set server 10.2.2.2
set authentication enable
set key-type sha256
set key-fmt hex
set key f3c79b2288a249f8a218646a10492706014fc9f4beb58fd3b6aab6d45782dd6ca
set key-id 123
next
end
end

» Example using ASCII:

config system ntp
config ntpserver

edit serverl
set server 10.2.2.2
set authentication enable
set key-type sha256
set key-fmt ascii
set key somepassword
set key-id 222

next
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end
end

3. Usediagnose system ntp status to confirm the connection was successful.

Time-base retention is configurable for the task monitor
and event log

Ly
.

g This information is also available in the FortiAnalyzer 8.0 Administration Guide:
e Task Monitor
e EventLog

Time-base retention is configurable for the task monitor and event log in FortiAnalyzer.

You can configure this setting in the FortiAnalyzer CLI:

config system local log disk setting
set log-max-days <integer between @ and 365>
end

X If the user set the log-max days to 0, it will return to default setting which is to use the disk quota as
the log retention rule.

Example: Configure the maximum logging days for the task monitor and event log

1. Inthis example, the current date is April 20, 2026, and there are logs in the Task Monitor and Event Log that
exists for 30 days.

2. Inthe FortiAnalyzer CLI, configure the log max days to 5.

config system local log disk setting
set log-max-days 5
end

3. Based on the configured settings above, by midnight all off the logs that are older than April 16, 2026 will be
truncated.

FortiAnalyzer Fabric

This section lists the new features added to FortiAnalyzer for FortiAnalyzer Fabric:

» Assign access to multiple fabric groups for a single admin on page 69
» FortiAnalyzer Fabric Supervisor HA on page 71
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Assign access to multiple fabric groups for a single admin

]
V-

g This information is also available in the FortiAnalyzer Fabric 8.0.0 Deployment Guide:
e Fabric Groups

In a FortiAnalyzer Fabric, the configured fabric groups can now contain other fabric groups. This allows you to
assign multiple fabric groups to a single admin for role-based access control (RBAC) in a FortiAnalyzer Fabric.

To create a fabric group containing other groups and assign it to a user:

1.

In System Settings > Fabric Management > Fabric Groups, create a new fabric group that contains other
fabric groups.

In the example below, there are existing fabric groups: Group_T and Group_2. The admin creates a new
fabric group (Group_3) and adds Group_1and Group_2 as members.

(™ eFAZ-155 Supervisor [IGualad >- @~ L2 (A admin~
@ Dashboards R Create Fabric Group x
32 Device Manager Group Name o3
2 Fortiview > Description contain Group_1 and Group_2
[ Log View >
W8 Incidents & Alerts >
B Reports > Add Member
| ¥ System Settings v Q

Administrators ® 3 Group_1

Admin Profiles B Group_2

Remote Authentication ... ®0@ eFAZ-137

Fabric Management: OJFTNT

SAML SSO [0 FortiAnalyzer

EEE 0O FortiCache

HA O FortiCarrier

Network [ FortiClient

Event Logs O FortiDeceptor

Certificates O FortiFirewallCarrier

Advanced O FortiMail

O FortiManager
2 entries selected
FERTINET g0, o« I

After Group_3 is created, it displays in the Fabric Groups table view with its assigned members (Group_1
and Group_2) listed below.
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System

eFAZ-155

I
fo)

Supervisor IINaluaZed >- @~ L2

A Warning: Image is not Certified

@ Dashboards

Fabric Settings I EGIN Fabric Connectors

B Device Manager

+ Create New T Delete Search..
& Fortiview >
®W | Name# IP Address + Platform + Logs + Average Log Rate(Logs/... + | Disk Quota Usage + Description +
M Log View > g 8 BGow.1@
MR Incidents & Alerts > 2 eFAZ-137 FortiAnalyzer-VMé4 @ Real Time 73
root @ Real Time 36 [ (1.47%)
B Reports >
8 & Mem-HA FortiAnalyzer-VM6é4 @ Real Time N/A
| ¥ system settings M root @RealTime  N/A W (9.49%)
Administrators o @ Growp_2@
Admin Profiles
[-] eFAZ-137 FortiAnalyzer-VM64 @ Real Time 73
Remote Authentication ...
[ VI—— Lab130 @ Real Time 34 I (6.83%)
SAML SSO 8 I Mem-HA FortiAnalyzer-VMé4 @ Real Time N/A
Settings Lab170 @ Real Time N/A I (0%)
HA B BGroup 3@ contain Group_1 and Group_
Network @ Group_1
Event Logs 2 Group_2
Certificates o = |Gow 4@
Advanced
-] eFAZ-137 FortiAnalyzer-VMé4 @ Real Time 73
FTNT @ Real Time 2 [ (0.15%)
B8 & Mem-HA FortiAnalyzer-VMé4 @ Real Time N/A

2. In System Settings > Administrators, create a new admin user and assign the newly created fabric group
(Group_3).

O~ L2 A admn~

SOV ENY HA Primary A-P [P

@ Dashboards > Edit Administrator - g3 x
8 Device Manager User Name -
&2 Fortiview > Avatar G+ AddPhoto — Remove Photo
Description
[ Log View >
B8 incidents & Alerts >
Y
07128
B Reports Admin Type LOCAL .
¥ System Settings FortiToken Cloud FortiToken Mobile Email SMS
Administrators Fabric Group All Groups
Admin Profiles Group_3 -
Remote Authentication ... Admin Profile Qa
Fabric Management JSON API Access
Group_1
SAMLSSO Therme Mode
q Group_2
Settings Trusted Hosts
Group_3 @ =
HA X
Meta Fields > Group_4
Network
Advanced Options >
Event Logs
Certificates
Advanced

The new user will have access to Group_3, which contains both Group_1 and Group_2. For example, see the
user's view of Device Manager displayed below.
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WR Incidents & Alerts >
[=] Collapse All | | [¥] Expand All © Show Charts v || Search @ .*
B Report:
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5 FAZ-VM | . FAZ-VMTM
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e v @ FAZVM ® FAZ-VMTM
[€] eFAZ-137 FortiAnalyzer-VMé4 @ Real Time FAZ-VMTM 79

FortiAnalyzer Fabric Supervisor HA

Ly

g This information is also available in the FortiAnalyzer Fabric 8.0.0 Deployment Guide:
e Supervisor HA

Beginning in FortiAnalyzer 8.0.0, high availability (HA) is supported on the FortiAnalyzer Fabric Supervisor.

When using HA for the FortiAnalyzer supervisor, only the Active-Passive operation mode is available. The
supervisor's Fabric Settings configuration is synced to secondary node, but the secondary node will not
establish connection to the FortiAnalyzer members until it becomes the primary node. In a failover scenario, all
FortiAnalyzer members will automatically connect to the new primary, and all data will sync to this new primary
as well.

Configuration is similar to normal FortiAnalyzer HA. For more information about HA configuration options, see
the FortiAnalyzer Administration Guide.

To configure FortiAnalyzer supervisor HA:

1. Inthe FortiAnalyzer supervisor, configure the unit as the primary node of an Active-Passive HA cluster.
The Active-Active HA operation mode is not available for FortiAnalyzer supervisors.
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[ Log View
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Administrators
Admin Profiles
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Advanced

O |Roles Serial Number 4 P2
O  Secondary FAZ-VMTM 0 10.3.15.206
O  Primary FAZ-VMTM 1 10.3.15.205

Cluster Settings

Operation Mode

Preferred Role

Initial Sync
Cluster Virtual IP

IP Address and Interface

Cluster Settings

Peer Address and Peer SN

Group Name

Group ID

Password

Heart Beat Interval
Heart Beat Interface
Failover Threshold
Priority

Log Data Sync

Secondary

Host Name %

eFAZ-206

eFAZ-205

Uptime/Downtime &
414 5h 22m 105
“41d 5h 26m 165

Initial Logs Sync &

ODone

Supervisor (SIS >- @~ L[\ 1 °admln

Configuration Sync &

Qin-sync

©Config will be synced to secondaries

Supervisor Data Sync Message & I

Opone

o

IP Address Interface Action
10.3.15.174 portl v X +
Peer Address Peer SN Action
10.3.15.206 FAZ-VMTM 0 x 4+
Super-HA
174 (1-255)

®

4
portl -
100 (1-120)

©

2. Inthe FortiAnalyzer to act as the secondary node, configure the HA options.

You can review the HA status in the top Cluster Status section. The Supervisor Data Sync column displays
the supervisor data sync status.

€eFAZ-206

[ Log View
MR incide:
B Reports

£ System Settings
Administrators

Admin Profiles

Remote Authentication ..

Certificates

Advanced

Cluster Status

supervisor [ETENNIN >- @« 01 (@) amn

O |Roles Serial Number 4 (28 Host Name & Uptime/Downtime ¢ Initial Logs Sync ¢ Configuration Sync & Supervisor Data Sync 4 Message & u
O | Secondary FAZ-VMTM 0 103.15.206 €eFAZ-206 #1d 5h 28m 135 ©Done Qin-sync ©Done
[m] Primary FAZ-VMTM 1 10.3.15.205 eFAZ-205 4#1d 5h 28m 05s
Cluster Settings
Operation Mode Standalone
Preferred Role Primary
Initial Sync (o)
Cluster Virtual IP
IP Address and Interface IP Address Interface Action
10.3.15.174 portl v X 4
Cluster Settings
Peer Address and Peer SN Peer Address Peer SN Action
10.3.15.205 FAZVMTM 1 x +
Group Name SuperHA
Group ID 174 (1-255)
Password . ®
Heart Beat Interval 1
Heart Beat Interface port1 -
Failover Threshold
Priority 100 (1-120)
Log Data Sync ©

FortiAnalyzer 8.0.0 New Features Guide

Fortinet Inc.

72



System

Once HA is established, the same FortiAnalyzer topology is displayed in both primary and secondary. To view
the topology in a node, go to System Settings > Fabric Management > Fabric Settings.

Supervisor [N >- @~ A1 o admin +

(™ eFAZ-205

PRI TNS Fabric Groups | Fabric Connectors

eFAZ-205
P: 10.3.15.205/1.1.1.1 S]

PPV sync Status: @ InSync

B Incid
B Report & Mem-HA ] 3 eFAZ-240 W
Reports 0
Log Rate: 42 Logs/sec f=C Log Rate: 47.8 Logs/sec
£ System setti Last Synced: a few seconds ago (2026-04-21 16:17:13) Member Last Synced: a few seconds ago (2026-04-21 16:17:01)
ystem Settings
P 10.3.15.175 P 10.3.15.240
HAMembers  10.315.237, 103.15.238 Syncstatus @ InSync
Sync Status ® InSync
CPU Usage 143%
CPU Usage 164 % Memory Usage 36 % 119 GB/32.9 GB
Memory Usage  30% 10.0GB/329GB Disk Usage 77.4% 380.18 GB / 491.08 GB
Disk Usage 262% 128.70GB / 491.08 GB
£ Login -4 & Login -

Same as in a normal FortiAnalyzer HA cluster, the secondary node cannot perform some actions. For example,
actions such as authorizing, rejecting or deleting members, and creating Fabric Groups are grayed out in the

secondary.
Supervisor [[ERNNIN >- @~ L1 () admin -
Fabric Settings x
Status [ o]
Fole  supenisor IR
Cluster Name Fabric

Session Port @

Secure Connection C

Apply

The secondary node can view members' devices, logs, FortiView, and Reports data, but the connection is
established through supervisor primary node. See examples below.
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e FortiView in both the secondary and primary:
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0% 100

e Log View in both the secondary and primary:
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Index

The following index provides a list of all new features added to FortiAnalyzer 8.0. The index allows you to
quickly identify the version where the feature first became available in FortiAnalyzer.

Select a version number to navigate in the index to the new features available for that release:

e 8.0.0on page 76

8.0.0

Security Operations

SOAR SIEM .

Incident and event .
management

Dashboards .
Asset and identity .
Other enhancements .

Log and Report

Logging .

Log forwarding .

Reports .

FortiAl

FortiAl .
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Playbook editor improvements on page 6

Alert explorer improvements on page 9

Al Access Visibility dashboard on page 10

Improvements to the user experience in the Asset and Identity Center
on page 12

FortiMQ connector for automated blocking on page 16
Machine learning for anomaly detection on page 21

FortiData incident support on page 33

FortiAnalyzer Fluentd supports the Azure Monitor Log Ingestion APl on
page 36

Anomaly login report on page 38
FortiDeceptor incident report on page 42
Shadow-Al report on page 48

FortiAl alert triage agent on page 53
FortiAl threat posture timeline on page 55
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Other enhancements .
FortiAnalyzer Fabric .
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Legal third party disclosure panel on page 59

Custom session labels in FortiAnalyzer event logs on page 61

SAML SSO supports SHA-256 and SHA-512 for both IdP and SP on
page 65

FortiAnalyzer supports NTPv4 with SHA-256 encryption on page 66
Time-base retention is configurable for the task monitor and event log
on page 68

Assign access to multiple fabric groups for a single admin on page 69
FortiAnalyzer Fabric Supervisor HA on page 71
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